User’s Guide
This User’s Guide is the on-screen guide to your Perfection V500 Office scanner. Click a
topic below to get started.

Overview of Your Scanner Features
These features help you create the best possible scans, no matter what
shape your original is in.
Guide to the Scanner Parts
Check this section to identify the parts of your scanner, read its light
status, and use its buttons.
Placing Originals on the Scanner
Follow the steps here to place your original documents, photos, film
strips, or slides on the scanner.
Scanning Documents or Photos
Follow the step-by-step instructions here to scan documents or photos
using any of the available scanning methods.
Scanning Film or Slides
Follow the step-by-step instructions here to scan film strips or slides
using any of the available scanning methods.
Scanning Special Projects
Follow the instructions here for specific scanning projects you may need
to create.

Using the Optional Automatic Document Feeder
Follow the steps here to install the optional Automatic Document Feeder
and use it to scan multi-page documents.
Maintenance
Follow the guidelines here to maintain and transport your scanner.

Solving Problems
If you have a problem using your scanner or its software, check here for
solutions.
Technical Specifications
Check here for technical details about your scanner and its accessories.

Safety
Copyright and Trademarks
Operating System Versions
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Overview of Your Scanner Features
These features help you create the best possible scans, no matter what
shape your original is in.

Color Restoration
Dust Removal
Digital ICE Technology and Digital ICE Lite Technology
Backlight Correction
Available Scanning Methods
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Guide to the Scanner Parts
Check these sections to identify the parts of your scanner, read its light
status, and use its buttons.

Scanner Parts
Light and Buttons
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Placing Originals on the Scanner
Follow the steps here to place your original documents, photos, film strips,
or slides on the scanner.

Placing Documents or Photos
Placing Film or Slides
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Scanning Documents or Photos
Follow the step-by-step instructions here to scan documents or photos using
any of the available scanning methods.

Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Selecting Epson Scan Settings

Home > Scanning Film or Slides

Scanning Film or Slides
Follow the step-by-step instructions here to scan film strips or slides using
any of the available scanning methods.

Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Selecting Epson Scan Settings
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Scanning Special Projects
Follow these instructions for specific scanning projects you may need to
create.

Restoring Color
Removing Dust Marks
Removing Dust and Scratch Marks from Film and Slides Using Digital
ICE Technology
Fixing Backlit Photos
Using the Scanner as a Copier
Scanning Directly to a PDF File
Scanning Directly to an E-mail
Converting Scanned Documents Into Editable Text
Scanning and Printing Color Accurate Images
Assigning Another Windows Program to a Scanner Button
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Using the Optional Automatic Document Feeder
Follow the steps here to install the optional Automatic Document Feeder and
use it to scan multi-page documents.

Unpacking the Automatic Document Feeder
Installing the Automatic Document Feeder
Loading Documents in the Automatic Document Feeder
Scanning Using the Automatic Document Feeder
Cleaning and Replacing the Paper Path Guide
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Maintenance
Follow the guidelines here to maintain and transport your scanner.

Cleaning the Scanner
Replacing the Scanner Light Source
Transporting the Scanner
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Solving Problems

Troubleshooting
If you have a problem using your scanner or its software, check here for solutions.
Reading the Status Light
Scanner Problems
Scanning Software Problems
Scan Quality Problems
Film or Slide Scanning Problems
Optional Automatic Document Feeder Problems
Uninstalling Your Scanning Software

Where To Get Help
Epson Technical Support
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Technical Specifications
Check here for technical details about your scanner and its accessories.

System Requirements
Scanner Specifications
Optional Automatic Document Feeder Specifications
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Important Safety Instructions
Restrictions on Copying
Read all these instructions, and follow all warnings and instructions marked on the
scanner.
In this document, warnings, cautions, and notes indicate the following:
Warnings

must be followed carefully to avoid bodily injury.

Cautions

must be observed to avoid damage to your equipment.

Notes

contain important information and useful tips on the operation of this
product.

Place the scanner close enough to the computer for the interface cable to
reach it easily. Do not place or store the scanner or the AC adapter
outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity, direct sunlight,
strong light sources, or rapid changes in temperature or humidity. Do not
use with wet hands.
Place the scanner and the AC adapter near an electrical outlet where the
adapter can be easily unplugged.
Caution:

Be sure the AC adapter meets the relevant local safety standards.

The AC adapter cord should be placed to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of the adapter cord and
do not allow the AC adapter or the cord to be stepped on or run over. Be
particularly careful to keep the AC adapter cord straight at the end and the
point where it enters the AC adapter.
Use only the AC adapter that comes with your scanner. Using any other
adapter could cause fire, electrical shock, or injury.
The AC adapter is designed for use with the scanner with which it was
included. Do not attempt to use it with other electronic devices unless
specified.
Use only the type of power source indicated on the AC adapter’s label, and
always supply power directly from a standard domestic electrical outlet with
the AC adapter that meets the relevant local safety standards.
When connecting this product to a computer or other device with a cable,
ensure the correct orientation of the connectors. Each connector has only
one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.
Avoid using outlets on the same circuit as photocopiers or air control
systems that regularly switch on and off.
If you use an extension cord with the scanner, make sure the total ampere
rating of the devices plugged into the extension cord does not exceed the
cord’s ampere rating. Also, make sure the total ampere rating of all devices
plugged into the electrical outlet does not exceed the electrical outlet’s
ampere rating. Do not place multiple loads on the electrical outlet.
Never disassemble, modify, or attempt to repair the AC adapter, scanner, or
scanner option by yourself except as specifically explained in the scanner’s
guides.
Do not insert objects into any opening as they may touch dangerous voltage
points or short out parts. Beware of electrical shock hazards.
Unplug the scanner and the AC adapter, and refer servicing to qualified
service personnel under the following conditions: The AC adapter or plug is
damaged; liquid has entered the scanner or the AC adapter; the scanner or
the AC adapter has been dropped or the case has been damaged; the
scanner or the AC adapter does not operate normally or exhibits a distinct
change in performance. (Do not adjust controls that are not covered by the
operating instructions.)
Unplug the scanner and the AC adapter before cleaning. Clean with a damp
cloth only. Do not use liquid or aerosol cleaners.
If you are not going to use the scanner for a long period, be sure to unplug
the AC adapter from the electrical outlet.
For United States users:
WARNING:

The cords included with this product contain chemicals, including
lead, known to the State of California to cause birth defects or other
reproductive harm. Wash hands after handling. (provided in
accordance with Proposition 65 in Cal. Health & Safety Code §
25249.5 et seq)

Restrictions on Copying
Observe the following restrictions to ensure responsible and legal use of your
scanner.
Copying of the following items is prohibited by law:
Bank bills, coins, government-issued marketable securities, government
bond securities, and municipal securities
Unused postage stamps, pre-stamped postcards, and other official postal
items bearing valid postage
Government-issued revenue stamps, and securities issued according to legal
procedure
Exercise caution when copying the following items:
Private marketable securities (stock certificates, negotiable notes, checks,
etc.), monthly passes, concession tickets, etc.
Passports, driver’s licenses, warrants of fitness, road passes, food stamps,
tickets, etc.
Note:

Copying these items may also be prohibited by law.

A note concerning responsible use of copyrighted materials
Epson encourages each user to be responsible and respectful of the copyright laws
when using any Epson product. While some countries' laws permit limited copying or
reuse of copyrighted material in certain circumstances, those circumstances may not
be as broad as some people assume. Contact your legal advisor for any questions
regarding copyright law.
Top
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Copyright and Trademarks
No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying,
recording, or otherwise, without the prior written permission of Seiko Epson
Corporation. No patent liability is assumed with respect to the use of the
information contained herein. Neither is any liability assumed for damages resulting
from the use of the information contained herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of
this product or third parties for damages, losses, costs, or expenses incurred by the
purchaser or third parties as a result of: accident, misuse, or abuse of this product
or unauthorized modifications, repairs, or alterations to this product.
Seiko Epson Corporation and its affiliates shall not be liable against any damages or
problems arising from the use of any options or any consumable products other
than those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.
EPSON® is a registered trademark and Exceed Your Vision is a registered logomark
of Seiko Epson Corporation.
Perfection® is a registered trademark and Micro Step Drive is a trademark of Epson
America, Inc.
Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft
Corporation.
Adobe®, Adobe Reader®, Acrobat®, and Photoshop® are registered trademarks of
Adobe Systems Incorporated.
Apple®, ColorSync®, and Macintosh® are registered trademarks of Apple Inc.
ABBYY® and ABBYY FineReader® names and logos are registered trademarks of
ABBYY Software House.
PRINT Image Matching® and the PRINT Image Matching logo are registered
trademarks of Seiko Epson Corporation. Copyright © 2001 Seiko Epson
Corporation. All rights reserved.
Intel® is a registered trademark of Intel Corporation.
PowerPC® is a registered trademark of International Business Machines Corporation.
Epson Scan Software is based in part on the work of the Independent JPEG Group.
libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names
of Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY
KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF
ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF
USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE
POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Digital ICE is a trademark of Kodak.
General Notice: Other product names used herein are for identification purposes
only and may be trademarks of their respective companies.
© 2009 Epson America, Inc. All rights reserved.
CPD-27555
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Operating System Versions
In this manual, the following abbreviations are used.
Windows refers to Windows Vista, XP, XP x64, and 2000.
Windows Vista refers to Windows Vista Ultimate Edition, Windows Vista
Home Premium Edition, Windows Vista Home Basic Edition, Windows Vista
Enterprise Edition and Windows Vista Business Edition.
Windows XP refers to Windows XP Home Edition and Windows XP
Professional.
Windows XP x64 refers to Windows XP Professional x64 Edition.
Windows 2000 refers to Windows 2000 Professional.
Macintosh refers to Mac OS X.
Mac OS X refers to Mac OS X 10.3.9 - 10.5.x.
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Color Restoration
Using the Color Restoration feature in your scanning software, you can transform an old,
faded, or badly exposed photo into one with true-to-life color and sharpness.
Original image

Color Restoration applied

For instructions on using this feature, see Restoring Color.
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Dust Removal
Using the Dust Removal feature in your scanning software, you can virtually “clean” the dust
marks from your originals as you scan them.
Original image

Dust Removal applied

Note:

Before scanning your originals, carefully remove any dust that you can see
on them.
Do not use Dust Removal to scan film or slides that do not contain dust
marks; otherwise your scanned image may be distorted or blurred.

For instructions on using this feature, see Removing Dust Marks.
For more accurate, hardware-based dust or scratch removal from your color film or slides, you
can use the Digital ICE Technology feature. See Digital ICE Technology and Digital ICE Lite
Technology for details.
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Digital ICE Technology and Digital ICE Lite Technology
Your scanner and its Epson Scan software are equipped with the Digital ICE Technology
and Digital ICE Lite Technology features that remove dust or scratch marks from color film
or slides.
Original image

Digital ICE Technology applied

Digital ICE Technology is a hardware-based dust removal method that is more accurate
than the Dust Removal feature. Digital ICE Technology can remove dust or scratch marks
without affecting the image composition. However, it takes longer to scan using Digital ICE
Technology and also uses more of your system resources. For faster (but less accurate)
dust removal, try removing dust marks using the Dust Removal feature. See Dust Removal
for details.
For instructions on using Digital ICE Technology to restore damaged images as you scan,
see Removing Dust and Scratch Marks from Film and Slides Using Digital ICE Technology.
Note:

You cannot use Dust Removal and Digital ICE Technology at the same
time.
You cannot use Digital ICE Technology when scanning printed photos
on the document table.
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Backlight Correction
Using the Backlight Correction feature in your scanning software, you can remove shadows
from photos that have too much background light.
Original image

Backlight Correction applied

For instructions on using this feature, see Fixing Backlit Photos .
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Available Scanning Methods
Using the Scanner Buttons
Using Epson Scan
Your scanner gives you a variety of ways to scan images. You can select the method that works
best for the project you are scanning and the way you like to work.

Using the Scanner Buttons
The buttons on the scanner let you automatically open scanning software and scan your image
to a program or file.

a.

Scan to PDF button

b.

Scan to E-mail button

c.

Copy button

d.

Start button

Documents or photos: See Starting a Scan With the Scanner Buttons.

Film or slides: See Starting a Scan With the Scanner Buttons.
Top

Using Epson Scan

Epson Scan lets you control all aspects of scanning and includes four modes.
Full Auto Mode lets you scan quickly and easily, without selecting any settings or
previewing your image. This is the default mode in Epson Scan.
Home Mode lets you customize some scanning settings and check their effects with a
preview image.
Office Mode lets you quickly select settings for scanning text documents and check
their effects with a preview image.
Professional Mode gives you total control of your scanning settings and lets you check
their effects with a preview image.
You can use Epson Scan as a “standalone” program to scan your image to a file on your
computer.
Documents or photos: See Starting a Scan With Epson Scan.
Film or slides: See Starting a Scan With Epson Scan.
You also use Epson Scan whenever you scan with another TWAIN-compliant program, such as
Adobe Photoshop Elements.
Documents or photos: See Starting a Scan With Another Scanning Program.
Film or slides: See Starting a Scan With Another Scanning Program.
Top
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Scanner Parts

a. scanner cover
b.

Scan to PDF button

c.

Scan to E-mail button

d.

Copy button

e.
Start button
f. power switch

a. document mat
b. transparency unit transportation lock
c. document table
d. carriage

a. DC inlet
b. OPTION port

c. scanner transportation lock
d. USB interface connector
e. cover cable
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Light and Buttons
Light
Buttons
The scanner has four buttons for scanning operations. The status light indicates whether the
scanner is operating normally.

a.

Scan to PDF button

b.

Scan to E-mail button

c.

Copy button

d.
Start button
e. status light

Light
The status light is next to the

Start button.

Color
Green

Indicator
Status

Ready to scan images.

On
Flashing

Orange
(None)

Flashing
Off

Meaning

Initializing or scanning.
An error has occurred. See Reading the Status Light for
more information.
The scanner is off.

Top

Buttons
Before using the scanner buttons, make sure you have installed Epson Scan and the Epson
Event Manager.
Button

Function

Start

Epson Scan starts.

Copy

The Copy Utility starts.

Scan to Email
Scan to PDF

Epson Scan automatically scans, then the Send File Via E-mail
window appears.
The Scan to PDF window appears.

Documents or photos: See Starting a Scan With the Scanner Buttons.
Film or slides: See Starting a Scan With the Scanner Buttons.
Top
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Placing Documents or Photos
Placing Large or Thick Documents
Before scanning a document, remember to respect the rights of copyright owners. Do not scan
published text or images without first checking their copyright status.
Caution:

Do not place heavy objects on the document table glass and do not press the glass
with too much force.

Open the scanner cover.
Make sure the document mat is installed inside the cover. If it is not installed, see
Replacing the Document Mat for instructions.

a. document mat
Place your document or photo face-down on the document table. Make sure the upper left
corner of the document or photo is against the rear right corner of the scanner, next to the
arrow mark.

An area 0.12 inch (3 mm) from the horizontal and the vertical sides of the scanner glass
cannot be scanned. If you place a document in the corner of the document table, move it
down and in slightly to avoid cropping.

a., b. Maximum unreadable area of 0.12 inch (3 mm)
If you are scanning multiple photos at once, position each photo at least 0.8 inch (20 mm)
apart from the others.
Close the scanner cover gently so that your original does not move.

Note:

Always keep the document table clean.
Do not leave photos on the document table for an extended period of time
as they may stick to the glass.

To scan your document or photo, see Starting a Scan With the Scanner Buttons.

Placing Large or Thick Documents
When you scan a large or thick document, you can remove the scanner cover.
Turn off the scanner using its power switch.
Disconnect the cover cable.

Open the scanner cover.

Pull the scanner cover straight up and off the scanner.

Turn on the scanner using its power switch.

Note:

When scanning without the scanner cover, gently press down on your document to
flatten it.

When you are finished scanning, replace the scanner cover in the reverse order that you
removed it.
Note:

Before connecting or disconnecting the cover cable, turn off the scanner using its
power switch.
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Placing Film or Slides
Removing the Document Mat
Placing Slides in the Holder
Placing Film in the Holder
Replacing the Document Mat

Removing the Document Mat
To scan film strips or slides, you need to remove the document mat from the scanner cover. This
uncovers the transparency unit window so your scanner can use it to scan your film or slides.
Make sure the cover cable is connected to the scanner’s OPTION port.

Note:

Before connecting or disconnecting the cover cable, turn off the scanner using its
power switch.

Open the scanner cover and gently slide up the document mat to remove it. Also make
sure the transparency unit transportation lock is unlocked.

Use a soft microfiber cloth to wipe the transparency unit window and the document table
before placing your film or slides.

a. transparency unit window
To place film for scanning, see Placing Film in the Holder.
To place slides for scanning, see Placing Slides in the Holder.
Top

Placing Slides in the Holder
You can scan up to four 35mm slides at a time using the slide portion of the film holder.
Note:

Make sure the white stickers on the back of the film holder and the areas
around them are not scratched, dusty, or covered in any way. If the areas
are obscured, the scanner may have trouble recognizing your slides.
Do not cover any of the small holes in the film holder or the slots on the
sides of the film holder.

Place the film holder on the document table so that it is aligned as shown. Make sure the
tab labelled “C” on the film holder fits into the area labelled “C” on the scanner.

Place up to four slides in the film holder with the shiny base side facing down. Your images
should appear backwards on the side that faces up. Your images should be oriented as
shown.

Make sure you removed the document mat. See Removing the Document Mat.
Close the scanner cover.
To scan your slides, see Starting a Scan With the Scanner Buttons.
When you are finished scanning slides, be sure to replace the document mat before scanning
documents or photos. See Replacing the Document Mat.
Top

Placing Film in the Holder

Placing 35mm Film Strips
Open the cover of the 35mm film strip holder.

Slide one or two film strips all the way into the film holder with the shiny base side facing
down. Your images and any wording on the film strips should appear backwards on the
side that faces up. You can scan up to 6 standard 35mm images per film strip.

Note:

Hold the edge of the film gently when touching the film; otherwise you may
damage the film.
Make sure the white stickers on the back of the film holder and the areas
around them are not scratched, dusty, or covered in any way. If the areas
are obscured, the scanner may have trouble recognizing your film.
Do not cover any of the small holes in the film holder or the slots on the
sides of the film holder.

Close the cover and press it down until you hear a click. Then press down on all the edges
of the cover to secure it. Make sure the cover is properly seated and closed all the way.

Make sure the film strip is placed as shown.

Place the film holder on the document table so that it is aligned as shown. Make sure the
tab labelled “A” on the film holder fits into the area labelled “A” on the scanner.

Make sure you removed the document mat. See Removing the Document Mat.
Close the scanner cover.
To scan your film, see Starting a Scan With the Scanner Buttons.
When you are finished scanning film, be sure to replace the document mat before scanning
documents or photos. See Replacing the Document Mat.

Placing Medium Format Film
Open the cover on the medium format film holder.
Slide one medium format film image into the film holder with the shiny base side facing
down. Your image and any wording on the film should appear backwards on the side that
faces up. Make sure the entire image frame is positioned in the film holder opening.

Note:

Hold the edge of the film gently when touching the film; otherwise you may
damage the film.
Do not cover any of the small holes in the film holder or the slot on the side
of the film holder; otherwise, the scanner may have trouble recognizing
which film holder you are using.

Close the cover over the film and press it down until it clicks. Then press down on all the
edges of the cover to secure it.

Make sure the film is placed as shown.

Place the film holder on the document table so that it is aligned as shown. Make sure the
tab labelled “B” on the film holder fits into the area labelled “B” on the scanner.

Make sure you removed the document mat. See Removing the Document Mat.

Close the scanner cover.

Note:

You cannot use Full Auto Mode to scan medium format film.

To scan your film, see Starting a Scan With the Scanner Buttons.
When you are finished scanning film, be sure to replace the document mat before scanning
documents or photos. See Replacing the Document Mat.
Top

Replacing the Document Mat
Replace the document mat by sliding it into the notches in the scanner cover. Make sure the
white surface faces outwards.

Top
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Starting a Scan With the Scanner Buttons

a.

Scan to PDF button

b.

Scan to E-mail button

c.

Copy button

d.

Start button
Start button
Place your original document or photo on the scanner. See Placing Documents or Photos.
To start a scan, press the
starts Epson Scan.

Start button on the scanner. Your computer automatically

From Epson Scan, you can select a scan mode and then scan and save your image to a
file on your computer. If the Mode box in the upper right corner of the window is set to
Full Auto Mode, see Using Full Auto Mode for instructions. If you are in Home or
Professional Mode, see Selecting Basic Settings. If you are in Office Mode, click the Help
button in the Epson Scan window for instructions on scanning using this mode.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not

Start the Correct Program.
If you want to change the scan mode, see Changing the Scan Mode.
Scan to PDF button
Place your original document or photo on the scanner. See Placing Documents or Photos.
To start a scan and save it as a PDF file on your computer, press the
button, then see Scanning Directly to a PDF File for instructions.

Scan to PDF

If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.
Copy button
Place your original document or photo on the scanner. See Placing Documents or Photos.
To use the scanner as a copier and automatically scan and print your image, you can
press the

Copy button. Your computer automatically starts the Copy Utility. See Using

the Scanner as a Copier for instructions.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.
Scan to E-mail button
Place your original document or photo on the scanner. See Placing Documents or Photos.
To scan an image and open your e-mail program so you can attach it to an e-mail
Scan to E-mail button. Epson Scan automatically starts
message, you can press the
scanning. See Scanning Directly to an E-mail for instructions.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.
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Starting a Scan With Epson Scan
If you want to scan an image and save it directly to a file, you can start Epson Scan as a
“standalone” program.
Place your original document or photo on the scanner. See Placing Documents or Photos.
Do one of the following to start Epson Scan.
Windows:
Double-click the EPSON Scan icon on your desktop.
Or select
or Start > All Programs or Programs > EPSON > EPSON Scan >
EPSON Scan.
Mac OS X:
Open the Applications folder and double-click the EPSON Scan icon.
The Epson Scan window appears.
Do one of the following, depending on the scan mode you are using.
Full Auto Mode
If the Mode box in the upper right corner of the window is set to Full Auto Mode,
click the Scan button. Epson Scan automatically scans the image and saves it as a
JPEG file in the Pictures or My Pictures folder. For instructions on selecting optional
settings, see Using Full Auto Mode.

Home or Professional Mode
If the Mode box in the upper right corner of the window is set to Home or
Professional Mode, see Selecting Basic Settings for instructions.
Office Mode
If the Mode box in the upper right corner of the window is set to Office Mode, click
the Help button in the Epson Scan window for instructions.
Note:

If you want to change the scan mode, see Changing the Scan Mode.
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Starting a Scan With Another Scanning Program
You can use any TWAIN-compliant scanning program, such as Adobe Photoshop
Elements, to scan with your scanner. You open the program, select Epson Scan as
your scanning program, and scan. When you are finished, the scanned image
opens in your scanning program so you can modify, print, and save it.
Note:

Not all versions of Photoshop Elements are fully compatible with
Windows Vista. If you are using Windows Vista, you may need to
upgrade to the latest version of Photoshop Elements.

Place your original document or photo on the scanner. See Placing
Documents or Photos.
Start your scanning
program.
Double-click the program icon from your desktop, if it is available, or do one
of the following.
Windows:
or Start > All Programs or Programs > program folder >
Select
program icon.
Mac OS X:
Open the Applications folder, select the program folder, and double-click
the program icon.
Select your program’s scanning option. (See your scanning program help for
instructions.)
In some programs, you must select the scanner as the “source” first. If you
see a Select Source option, choose it and select your scanner there first.
If you’re using Photoshop Elements, do one of the following.

Windows:
Click Edit and Enhance Photos, then open the File menu and select
Import.
Mac OS X:
Click Close in the Welcome window (if it appears), then open the File menu
and select Import.
Note:

You can also scan using the Start From Scratch or Quickly Fix
Photos options in Photoshop Elements. See the Photoshop Elements
Help utility for instructions.

Select EPSON Perfection V500.

Note for Windows Vista and XP users:

Do not choose a WIA option for your scanner from the Import or
Acquire list; you will not be able to use all the features of your
scanner.

Epson Scan starts automatically. For instructions on using it, see Selecting
Epson Scan Settings.
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Selecting Epson Scan Settings
Overview of the Epson Scan Modes
Selecting File Save Settings
Using Full Auto Mode
Changing the Scan Mode
Selecting Basic Settings
Selecting the Scan Resolution
Previewing and Adjusting the Scan Area
Adjusting the Color and Other Image Settings
Selecting the Scan Size
Finishing the Scan

Overview of the Epson Scan Modes
Epson Scan lets you control all aspects of scanning and includes three modes.
Full Auto Mode lets you scan quickly and easily, without selecting any settings or
previewing your image. This is the default mode in Epson Scan.
Full Auto Mode is best when you need to scan documents or photos at 100% size and
you do not need to preview the images before scanning. You can restore faded colors or
remove dust marks by clicking the Customize button.
See Using Full Auto Mode for instructions on scanning in this mode.
Home Mode lets you customize some scanning settings and check their effects with a
preview image.
Home Mode is best when you want to preview images of photos, film, or slides before
scanning them. You can size the image as you scan, adjust the scan area, and adjust
many image settings, including color restoration, dust removal, Digital ICE Technology
(for color film and slides only), and backlight correction.
See Changing the Scan Mode for instructions on switching to Home Mode.
See Selecting Basic Settings for scanning steps.
Office Mode lets you quickly select settings for scanning text documents and check
their effects with a preview image.

See Changing the Scan Mode for instructions on switching to Office Mode.
For instructions on scanning using this mode, select Office Mode and then click the Help
button in the Epson Scan window.
Professional Mode gives you total control of your scanning settings and lets you check
their effects with a preview image.
Professional Mode is best when you want to preview your image and make extensive,
detailed corrections to it before scanning. You can sharpen, color correct, and enhance
your image with a full array of tools, including color restoration, dust removal, Digital
ICE Technology (for color film and slides only), and backlight correction.
See Changing the Scan Mode for instructions on switching to Professional Mode.
See Selecting Basic Settings for scanning steps.
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Selecting File Save Settings
When you see the File Save Settings window, you need to select the location, name, and format
of the scanned image file you want to save.
Do one of the following to open the File Save Settings window.
Full Auto Mode
In the standby window, click the Customize button, then click the File Save
Settings button. (If you started Epson Scan from a program like Adobe Photoshop
Elements, this button doesn’t appear.)
Home or Professional Mode
File Save Settings button to the right of the Scan button. (If you
Click the
started Epson Scan from a program like Adobe Photoshop Elements, this button
doesn’t appear.)
In the File Save Settings window, specify the file folder in which you want to save your
scanned image. Click the Documents or Pictures radio button, or the My Documents or
My Pictures radio button.
If you want to select another folder, click Other, then click Browse (Windows) or Choose
(Mac OS X) and select the folder. If you want to save your image on the desktop, simply
click Other.

Specify a file name prefix with an alphanumeric character string. A 3-digit number is
automatically added to the file name, but you can change the Start Number if you like. If
you are scanning multiple images at once, each image will receive a different 3-digit
number.
Note:

With Windows, the following characters cannot be used in the prefix.
\, /, :, ., *, ?, ", <, >, │
With Mac OS X, you cannot use a colon (:) in the prefix.

Select a file format as described in the following table. Depending on the format, the
Options button may be available for making detailed settings.

Format
(File
Extension)

Explanation

BITMAP (*.
BMP)
(Windows
only)

A standard image file format for Windows. Most Windows
programs, including word processing programs, can read images
in this format.

JPEG (*.
JPG)

A compressed file format in which the compression level can be
selected. The JPEG format lets you highly compress image data.
However, the higher the compression, the lower the image
quality. Any lost image quality data cannot be restored, and the
quality deteriorates each time the data is saved. The TIFF format
is recommended when modification and retouching are required.

Multi-TIFF
(*.TIF)

A TIFF format where multiple pages are saved to the same file.
You can also edit the scanned images before saving them. See
Epson Scan Help for details. To open Multi-TIFF files, you need a
program that supports it.

PDF (*.PDF)

A document format that can be read on both Windows and
Macintosh systems (platform independent). To use PDF
documents in Windows, you need Adobe Reader or Acrobat. Multipage documents can be saved as one PDF file. When you save
color or grayscale images in PDF, you can select a compression
level. You can also edit the scanned images before they are
saved. See Scanning Directly to a PDF File for details.

PICT (*.
PCT)
(Macintosh
only)

A standard image file format for Macintosh. Most Macintosh
programs, including word processing programs, can read images
in this format.

PRINT
Image
Matching II
JPEG (*.
JPG) or
TIFF (*.TIF)

A file format that includes PRINT Image Matching II data for
enhanced quality and a wider color range. Print Image Matching
II compatible printers can then print this data for brilliant, true-tolife results. (PRINT Image Matching data does not affect the way
the image displays on the screen.) Available in JPEG or TIFF
format.

TIFF (*.TIF)

A file format created for exchanging data between many
programs, such as graphic and DTP software. When scanning
black & white images, you can specify the compression type.

The checkboxes at the bottom of the window give you these options.
Overwrite any files with the same name
Select this option if you want to reuse the selected file name and location and
overwrite previous files with the same names.
Show this dialog box before next scan
Select this option if you want the File Save Settings window to appear automatically
before you scan (Home or Professional Mode only). If you deselect it, you must click
the

File Save Settings button to open the window in Home or Professional Mode.

Open image folder after scanning

Select this option if you want Windows Explorer or the Macintosh Finder to
automatically open the folder where your scanned image is saved when Epson Scan
finishes scanning.
Click OK.
In Full Auto Mode, click OK again, then click Scan. In Home or Professional Mode, click
Preview, then click Scan.
The scanned image is automatically saved in the file and location you chose.
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Using Full Auto Mode
When you start Epson Scan for the first time, it runs in Full Auto Mode and displays the Epson
Scan standby window.

If you want to select a custom resolution, restore faded colors, or remove dust marks, click
the Customize button. You see the Customize window.

Note:

If you started scanning from a program like Adobe Photoshop Elements, the File
Save Settings button is not available in the Customize window.

Select your settings and click OK. (For details on selecting settings, click the Help button.)
Click the Scan button. Epson Scan starts scanning in Full Auto Mode.
Epson Scan previews your image, detects whether it is a document or photo, and selects
the scan settings automatically. After a moment, you see a small preview of your image in
the Epson Scan window.

Note:

If you need to change any settings, click the Pause button. You will return
to the Epson Scan standby window.
If you need to cancel scanning, click the Cancel button when it appears.

Depending on how you started Epson Scan, the program saves the file to the location you
specified or opens the scanned image in your scanning program. See Finishing the Scan for
details.

Note:

If you have a problem scanning your photo or document in Full Auto Mode,
try scanning it in Home or Professional Mode instead.
If you want to change the scan mode, see Changing the Scan Mode.
If your image is not rotated correctly, see Images Are Rotated Incorrectly.
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Changing the Scan Mode
To change the scan mode, click the arrow in the Mode box in the upper right corner of the Epson
Scan window. Then select the mode you want to use from the list that appears.

Note:

The mode you select remains in effect when you start Epson Scan the next time.

For instructions on scanning using these modes, see:
Full Auto Mode: Using Full Auto Mode.
Home or Professional Mode: Selecting Basic Settings.
Office Mode: After you select Office Mode, click the Help button in the Epson Scan
window.
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Selecting Basic Settings

When you start Epson Scan in Home or Professional Mode, you see the main Epson Scan window.
Home Mode

Professional Mode

Before you scan your document or photo, you need to select these basic settings.
Original settings. These tell Epson Scan the type of document or photo you are scanning.
Destination settings. These tell Epson Scan how you plan to use your scanned image.
Follow these steps to select the basic settings for a document or photo in Epson Scan.
Do one of the following to select your document type.
Home mode:
Click the arrow to open the Document Type list and select the type of original you are
scanning. Then click the Color, Grayscale, or Black&White button to match the colors in
the original.
Professional mode:
Click the arrow to open the Document Type list and select Reflective (for scanning a
photo or document). Then click the arrow in the Auto Exposure Type list and select
Document or Photo.
Do one of the following to select your destination setting(s).
Home mode:
In the Destination box, click the button for the way you plan to use the scanned image.
Screen/Web for images you will view only on a computer screen or post on the
web.
Printer for images you will be printing or converting to editable text with an OCR
(Optical Character Recognition) program.
Other if you want to select a specific resolution for other purposes.
Professional mode:
Click the arrow to open the Image Type list and select the image type you are scanning.
Image
Type
setting

Type of image you are scanning

48-bit Color

Color photo that you may want to modify in a 48-bit imageediting program
If you use this setting, your image file size will be significantly
larger than if you use the 24-bit Color or Color Smoothing
settings.

24-bit Color

Color photo

Color
Smoothing

Color graphics, such as a chart or graph

16-bit
Grayscale

Black-and-white photo with many shades of gray
If you use this setting, your image file size will be larger than if
you use the 8-bit Grayscale setting.

8-bit
Grayscale

Black-and-white photo with just a few shades of gray

Black &
White

Document with black text and/or line art

If you select 8-bit Grayscale or Black & White in Professional Mode, you can also select
a Color Enhance or Dropout Image Option setting (to enhance or dropout the color you
select). To access the setting, click the + (Windows) or
Image Type.

(Mac OS X) button next to

In Home Mode, Epson Scan selects a default resolution setting based on the Destination
setting you select. See Selecting the Scan Resolution to continue scanning.
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Selecting the Scan Resolution
In Home Mode, you can change the resolution only if you select Other as the Destination setting.

In Professional Mode, you can select the resolution you want at any time.

Before you select the scan resolution, you should consider whether you will enlarge your images
before or after you scan them. Follow these guidelines.
You will not be enlarging the images.
If you will scan the images at 100% size or smaller and will not enlarge them later, you
can accept the Resolution setting selected by Epson Scan based on your Destination
setting (Home Mode only).
You will enlarge the images as you scan them (increase the Target Size
setting).
If you will enlarge the images in Epson Scan so you can use them at a larger size, you
can accept the Resolution setting selected by Epson Scan based on your Destination
setting (Home Mode only).

You will scan the images at their original size, but then enlarge them later in
an image-editing program.
If you plan to enlarge your images later in an image-editing program, you need to
increase the Resolution setting to retain a high image quality after enlargement.
Increase the resolution by the same amount you will increase the image size. For
example, if the resolution is 300 dpi (dots per inch), but you will increase the image size
to 200% in an image-editing program, change the Resolution setting to 600 dpi in
Epson Scan.
Click the arrow next to the Resolution list and select the number of dots per inch at which you
want to scan. See the table below for some guidelines.
What you will do with
the scanned image

Suggested scan resolution

Send via e-mail, upload to
web, view only on the
screen

96 to 150 dpi

Print, convert to editable
text (OCR)

300 dpi

Fax

200 dpi

Enlarge after scanning at
100%

Increase Resolution setting by same amount you will
increase image size after scanning

After selecting the Resolution, you can preview your image and make any necessary
adjustments. See Previewing and Adjusting the Scan Area to continue scanning.
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Previewing and Adjusting the Scan Area
Once you have selected your basic settings and resolution in Home or Professional Mode, you
can preview your image and select or adjust the area of the image(s) you want to scan. Epson
Scan displays the preview image(s) in a separate Preview window on your screen.
There are two types of preview.
Normal preview displays your previewed images in their entirety. You must select the
scan area and make any image quality adjustments manually. This is the default
preview type in Professional Mode, but you can also select it in Home Mode, if available.
Thumbnail preview displays your previewed images as thumbnails. Epson Scan
automatically locates the edges of your scan area and applies automatic exposure
settings to the images. This is the default preview type in Home Mode, but you can also
select it in Professional Mode, if available.
Note:

Depending on your document type and other settings, the normal preview may be
automatically selected and you will not be able to change to thumbnail preview.

Follow these steps to preview your image(s) in Home or Professional Mode.
Click the Preview button toward the bottom of the Epson Scan window. If you want to
change the preview type, click the Thumbnail checkbox under the Preview button, if it is
available.

Epson Scan prescans your image(s) and displays them in one of the following Preview
windows.
Normal preview

Thumbnail preview

If you are viewing the normal preview, you can do the following to adjust the image(s).

To select your scan area, click the
auto locate icon to place a marquee that
marks the edges of your image area. You can move the marquee to change the scan
area. See Adjusting the Scan Area (Marquee) for instructions.
Note:

If you are going to scan at a different size than your original, you must first
select your Target Size and automatically create a marquee that is
proportioned to that size. See Selecting the Scan Size for instructions. You
can then copy the marquee and place it on each image you will scan at that
size.

To zoom in on an image, click inside the scan area and click the Zoom button.
Epson Scan prescans again and displays a larger preview on the Zoom tab. (Your
other images are still previewed at the original size on the Preview tab.)
To adjust the image quality, click the image(s) you want to modify and make the
adjustments as described in Adjusting the Color and Other Image Settings.
If you are viewing the thumbnail preview, you can do the following to adjust the image(s).
To zoom in on an image, double-click its thumbnail, or click the thumbnail and then
click the Full Size tab near the top of the Preview window. (This feature is only
available when you are scanning multiple images at the same time.)
To rotate an image or flip it horizontally (like a mirror image), click its thumbnail and
then click the

rotation icon or

mirroring icon.

To adjust the scan area to crop your image, you can create and move a marquee
that marks the edges of your scan. See Adjusting the Scan Area (Marquee) for
instructions.
To adjust the image quality, click the image(s) you want to modify and make the
adjustments as described in Adjusting the Color and Other Image Settings. If you
want to apply the adjustments to all your images, click the All button.
Note:

If your image is not rotated correctly, see Images Are Rotated Incorrectly.

When you have finished adjusting the scan area, and modifying the color and image
settings, you can select the size of your scanned image, if you have not already selected it.
See Selecting the Scan Size for instructions.

Adjusting the Scan Area (Marquee)
A marquee is a moving dotted line that appears on the edges of your preview image to indicate
the scan area.

You can move the marquee, adjust its size, and create multiple marquees on one image (normal
preview only) to scan different image areas in separate scan files. Follow these steps.
To draw a marquee, move your cursor over a preview image. The pointer becomes a set of
cross-hairs.
Position the pointer in the area where you want to place the corner of your marquee and
click. Hold down the mouse button and drag the cross-hairs over the image to the opposite
corner of the desired scan area. Then release the mouse button. You see the moving
dotted line of the marquee.

Do one of the following to adjust the marquee.
To move the marquee, position your cursor inside the marquee. The pointer
becomes a hand. Click and drag the marquee to the desired location.

To resize the marquee, position your cursor over the edge or corner of the marquee.
The pointer becomes a straight or angled double-arrow. Click and drag the edge or
corner to the desired size.

Note:

To restrict movement of the marquee to vertical or horizontal only, hold
down the Shift key as you move the marquee. To restrict sizing of the
marquee to the current proportions, hold down the Shift key as you resize
the marquee.
For best results and image exposure, make sure all sides of the marquee
are located inside the preview image. Do not include any of the area around
the preview image in the marquee.

To draw multiple marquees (up to 50; normal preview only), you can just draw them as
copy marquee icon to create additional
described in steps 1 through 3, or click the
marquees of the same size. You can move and resize all the marquees as described in step
3. To delete a marquee, click inside it and click the

delete marquee icon.

Note:

If you draw multiple marquees, make sure you click the All button in the Preview
window before you scan; otherwise, only the area inside of the last marquee you
drew will be scanned.
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Adjusting the Color and Other Image Settings
Once you have previewed your images and adjusted the scan area, you can modify the image
quality, if necessary. Epson Scan offers a variety of settings for improving color, sharpness,
contrast, and other aspects affecting image quality.
Before you make adjustments, be sure to click the image or marquee for the area you want to
adjust. In Professional Mode, you may need to scroll down to the Adjustments area of the main
Epson Scan window.

The table below describes the settings available in Home and/or Professional Mode. For details
on adjusting these settings, click Help in the Epson Scan window.
When you are finished making adjustments, you can size your scanned images (see Selecting
the Scan Size) or go ahead and click Scan (see Finishing the Scan).
Setting

Available mode(s) and description

Color Restoration

Home and Professional:
Restores the colors in faded photos automatically.

Dust Removal

Home and Professional:
Removes dust marks from your originals automatically. The
results of Dust Removal do not appear in the preview, only in
your scanned image. In Professional Mode, the level of Dust
Removal is adjustable.

Backlight
Correction

Home and Professional:
Removes shadows from photos that have too much background
light. In Professional Mode, the level of Backlight Correction is
adjustable.

Brightness

Home and Professional:
Adjusts the overall image lightness and darkness.
In Home Mode, click the Brightness button to access the
Brightness setting.
In Professional Mode, click the
access the Brightness setting.

Contrast

Home and Professional:
Adjusts the difference between the light and dark areas of the
overall image.
In Home Mode, click the Brightness button to access the
Contrast setting.
In Professional Mode, click the
access the Contrast setting.

Saturation

Image Adjustment button to

Professional only:
Adjusts the density of colors in the overall image.
Click the
setting.

Color Balance

Image Adjustment button to

Image Adjustment button to access the Saturation

Professional only:
Adjusts the balance of red, green, and blue colors in the overall
image.
Image Adjustment button to access the Color
Click the
Balance setting.

Auto Exposure

Home: Automatically applied.
Professional: Automatically applied. To adjust the level of
exposure, click the Configuration button, click the Color tab,
and adjust the Auto Exposure Level slider.
If you don't want Auto Exposure automatically applied, deselect
Continuous Auto Exposure in the Color tab. Then, click the
Auto Exposure button (Professional Mode only) or reselect
Continuous Auto Exposure whenever you want to apply this
setting to an image.

Unsharp Mask

Home: Automatically applied.
Professional: Turned on by default. Unsharp Mask makes the
edges of image areas clearer for an overall sharper image. The
level of sharpness is adjustable. Turn off to leave softer edges.

Descreening

Home and Professional:
Improves results when scanning magazine or newspaper images
that include screening in their original print processes. The
results of Descreening do not appear in the preview, only in your
scanned image. In Professional Mode, the method of Descreening
is selectable.

Histogram

Professional only:
Provides a graphical interface for adjusting highlight, shadow,
and gamma levels individually. For advanced users only.
Histogram Adjustment button to access the
Click the
Histogram setting.

Tone Correction

Professional only:
Provides a graphical interface for adjusting tone levels
individually. For advanced users only.
Tone Correction button to access the Tone
Click the
Correction setting.

Color Palette

Professional only:
Provides a graphical interface for adjusting mid-tone levels, such
as skin tones, without affecting the highlight and shadow areas of
the image. For advanced users only.
Color Palette button to use the Color Palette
Click the
settings. See Using the Color Palette Function (Professional Mode
Only) for instructions.

Threshold

Home and Professional:
Adjusts the level at which the black areas in text and line art are
delineated, improving text recognition in OCR programs.
(Available only when you select Black & White as the Image
Type setting.)
In Home Mode, click the Brightness button to access the
Threshold setting.

Text
Enhancement

Home only:
Improves the definition of text and line art. Enhances text
recognition when scanning text documents.

Auto Area
Segmentation

Home only:
Makes grayscale images clearer and text recognition more
accurate by scanning text in black & white while retaining the
grayscale of the image. (Available only when you select
Black&White as the Image Type setting.)

Note:

To view the red, green, and blue levels at particular points in your preview
densitometer icon in the
image as you make adjustments, click the
preview window and click an image area. See Epson Scan Help for details.
Certain settings may not be available, or may be automatically selected,
depending on the type of image you are previewing and other settings you
have selected.
You can customize how certain Epson Scan settings behave by clicking the
Configuration button and changing settings in the window that appears.
See Epson Scan Help for details.
To undo any image quality adjustments you make to the preview image,
click the Reset button (if available), turn off the setting, or preview your
image again.
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Selecting the Scan Size
You can scan your images at their original size, or you can reduce or enlarge their size as you
scan them. You do this using the Target Size setting in Home or Professional Mode.
Home Mode

Professional Mode

If you are going to scan your image to a particular size, you should select the Target Size setting
after previewing it, but before adjusting your scan area (indicated by the marquee). This sets
the scan area to the correct proportions so your image will not be cropped unexpectedly.
For instructions on previewing your image(s), see Previewing and Adjusting the Scan Area. Then
follow these steps to select the Target Size setting.
You can choose a predefined scan size from the Target Size list. Click the arrow in the list
and select the size you want. A marquee (dotted line) proportioned for that size appears
on your preview image.

If you need to create a scan size that is not in the Target Size list, you can create a custom
size. Click the arrow in the list and select Customize. You see the Target Size window.

Type a name for your custom size, enter the size, click the Save button, then click OK.
Your new size appears in the Target Size list.
In Professional Mode, you can fine-tune the size using additional tools. Click the +
(Windows) or

(Mac OS X) next to Target Size to display these tools.

To size your image by a certain percentage, adjust the Scale value.
To change the way your image is cropped, turn Trimming on or off. (See Epson
Scan Help for details.)
To unlock the proportions of your scan size, click the
marquee or enter new width/height measurements.

lock icon. Then adjust the

Once you have selected your scan size, you can click and drag the marquee to the area in
the image you want to scan. For details, see Adjusting the Scan Area (Marquee). The
marquee proportions are retained as you adjust it.
If you need to rotate the marquee for a landscape or portrait image without changing its
aspect ratio, click the
Original Target Size.)

orientation icon. (Not available if you are scanning at the

Note:

For more information about using the Target Size tools, click Help in the Epson
Scan window.

Now you are ready to scan your image(s). Click the Scan button, and see Finishing the
Scan for instructions.
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Finishing the Scan
What happens after you scan depends on how you started your scan.
Start button or running Epson Scan as a
If you started your scan by pressing the
standalone program and you used Full Auto Mode, your scanned image is saved in the
file format and location you chose. If you did not choose any file save settings, it is
saved as a JPEG file in the Pictures or My Pictures folder.

If you started your scan by pressing the
Start button or running Epson Scan as a
standalone program and you used Home or Professional Mode, you see the File Save
Settings window. This lets you select the name and location of your saved scan files.
See Selecting File Save Settings for details.
If you started your scan from a scanning program such as Adobe Photoshop Elements,
your scanned image(s) open in the program window. If Epson Scan does not
automatically close after scanning, click Close to close the Epson Scan window and view
your image(s) in the program.
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Home > Scanning Film or Slides

Starting a Scan With the Scanner Buttons

a.

Scan to PDF button

b.

Scan to E-mail button

c.

Copy button

d.

Start button
Start button
Place your film or slides on the scanner. See Placing Film or Slides for instructions.
To start a scan, press the
starts Epson Scan.

Start button on the scanner. Your computer automatically

From Epson Scan, you can select a scan mode and then scan and save your image to a
file on your computer. If the Mode box in the upper right corner of the window is set to
Full Auto Mode, see Using Full Auto Mode for instructions. If you are in Home or
Professional Mode, see Selecting Basic Settings.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.

If you want to change the scan mode, see Changing the Scan Mode.
Scan to PDF button
Place your film or slides on the scanner. See Placing Film or Slides for instructions.
To start a scan and save it as a PDF file on your computer, press the
button, then see Scanning Directly to a PDF File for instructions.

Scan to PDF

If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.
Copy button
Place your film or slides on the scanner. See Placing Film or Slides for instructions.
To use the scanner as a copier and automatically scan and print your image, you can
press the

Copy button. Your computer automatically starts the Copy Utility. See Using

the Scanner as a Copier for instructions.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.
Scan to E-mail button
Place your film or slides on the scanner. See Placing Film or Slides for instructions.
To scan an image and open your e-mail program so you can attach it to an e-mail
Scan to E-mail button. Epson Scan automatically starts
message, you can press the
scanning. See Scanning Directly to an E-mail for instructions.
If a program does not start when you press a button, see Pressing a Scanner Button Does Not
Start the Correct Program.

Home > Scanning Film or Slides

Starting a Scan With Epson Scan
If you want to scan film or slides and save them directly to files, you can start Epson Scan as a
“standalone” program.
Place your film or slides on the scanner. See Placing Film or Slides for instructions.
Do one of the following to start Epson Scan.
Windows:
Double-click the EPSON Scan icon on your desktop.
Or select
or Start > All Programs or Programs > EPSON > EPSON Scan >
EPSON Scan.
Mac OS X:
Open the Applications folder and double-click the EPSON Scan icon.
The Epson Scan window appears.
Do one of the following, depending on the scan mode you are using.
Full Auto Mode
If the Mode box in the upper right corner of the window is set to Full Auto Mode,
click the Scan button. Epson Scan automatically scans the image and saves it as a
JPEG file in the Pictures or My Pictures folder. For instructions on selecting optional
settings, see Using Full Auto Mode.

Home or Professional Mode
If the Mode box in the upper right corner of the window is set to Home or
Professional Mode, see Selecting Basic Settings for instructions.
Note:

In Full Auto Mode, you can scan only 35mm color negative film strips or
color positive slides. If you want to scan other types of film, change to
Home or Professional Mode.
If you want to change the scan mode, see Changing the Scan Mode.

Home > Scanning Film or Slides

Starting a Scan With Another Scanning Program
You can use any TWAIN-compliant scanning program, such as Adobe Photoshop
Elements, to scan with your scanner. You open the program, select Epson Scan as
your scanning program, and scan. When you are finished, the scanned image
opens in your scanning program so you can modify, print, and save it.
Note:

Not all versions of Photoshop Elements are fully compatible with
Windows Vista. If you are using Windows Vista, you may need to
upgrade to the latest version of Photoshop Elements.

Place your film or slides on the scanner. See Placing Film or Slides for
instructions.
Start your scanning
program.
Double-click the program icon from your desktop, if it is available, or do one
of the following.
Windows:
or Start > All Programs or Programs > program folder >
Select
program icon.
Mac OS X:
Open the Applications folder, select the program folder, and double-click
the program icon.
Select your program’s scanning option. (See your scanning program help for
instructions.)
In some programs, you must select the scanner as the “source” first. If you
see a Select Source option, choose it and select your scanner there first.
If you’re using Photoshop Elements, do one of the following.

Windows:
Click Edit and Enhance Photos, then open the File menu and select
Import.
Mac OS X:
Click Close in the Welcome window (if it appears), then open the File menu
and select Import.
Note:

You can also scan using the Start From Scratch or Quickly Fix
Photos options in Photoshop Elements. See the Photoshop Elements
Help utility for instructions.

Select EPSON Perfection V500.

Note for Windows Vista and XP users:

Do not choose a WIA option for your scanner from the Import or
Acquire list; you will not be able to use all the features of your
scanner.

Epson Scan starts automatically. For instructions on using it, see Selecting
Epson Scan Settings.

Home > Scanning Film or Slides

Selecting Epson Scan Settings
Overview of the Epson Scan Modes
Selecting File Save Settings
Using Full Auto Mode
Changing the Scan Mode
Selecting Basic Settings
Selecting the Scan Resolution
Previewing and Adjusting the Scan Area
Adjusting the Color and Other Image Settings
Selecting the Scan Size
Finishing the Scan

Overview of the Epson Scan Modes
Epson Scan lets you control all aspects of scanning and includes three modes.
Full Auto Mode lets you scan quickly and easily, without selecting any settings or
previewing your image. This is the default mode in Epson Scan.
Full Auto Mode is best when you need to scan your images at 100% size and you do not
need to preview the images before scanning. You can restore faded colors or remove
dust marks by clicking the Customize button.
See Using Full Auto Mode for instructions on scanning in this mode.
Note:

In Full Auto Mode, you can scan only 35mm color negative film strips or color
positive slides. To scan other types of film, use Home or Professional Mode.

Home Mode lets you customize some scanning settings and check their effects with a
preview image.
Home Mode is best when you want to preview images of photos, film, or slides before
scanning them. You can size the image as you scan, adjust the scan area, and adjust

many image settings, including color restoration, Digital ICE Technology (for color film
and slides only), and backlight correction.
See Changing the Scan Mode for instructions on switching to Home Mode.
See Selecting Basic Settings for scanning steps.
Professional Mode gives you total control of your scanning settings and lets you check
their effects with a preview image.
Professional Mode is best when you want to preview your image and make extensive,
detailed corrections to it before scanning. You can sharpen, color correct, and enhance
your image with a full array of tools, including color restoration, dust removal, Digital
ICE Technology and Digital ICE Lite Technology (for color film and slides only), and
backlight correction.
See Changing the Scan Mode for instructions on switching to Professional Mode.
See Selecting Basic Settings for scanning steps.
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Selecting File Save Settings
When you see the File Save Settings window, you need to select the location, name, and format
of the scanned image file you want to save.
Do one of the following to open the File Save Settings window.
Full Auto Mode
In the Standby window, click the Customize button, then click the File Save
Settings button. (If you started Epson Scan from a program like Adobe Photoshop
Elements, this button doesn’t appear.)
Home or Professional Mode
File Save Settings button to the right of the Scan button. (If you
Click the
started Epson Scan from a program like Adobe Photoshop Elements, this button
doesn’t appear.)
In the File Save Settings window, specify the file folder in which you want to save your
scanned image. Click the Documents or Pictures radio button, or the My Documents or
My Pictures radio button.
If you want to select another folder, click Other, then click Browse (Windows) or Choose
(Mac OS X) and select the folder. If you want to save your image on the desktop, simply
click Other.

Specify a file name prefix with an alphanumeric character string. A 3-digit number is
automatically added to the file name, but you can change the Start Number if you like. If
you are scanning multiple images at once, each image will receive a different 3-digit
number.
Note:

With Windows, the following characters cannot be used in the prefix.
\, /, :, ., *, ?, ", <, >, │
With Mac OS X, you cannot use a colon (:) in the prefix.

Select a file format as described in the following table. Depending on the format, the
Options button may be available for making detailed settings.

Format
(File
Extension)

Explanation

BITMAP (*.
BMP)
(Windows
only)

A standard image file format for Windows. Most Windows
programs, including word processing programs, can read images
in this format.

JPEG (*.
JPG)

A compressed file format in which the compression level can be
selected. The JPEG format lets you highly compress image data.
However, the higher the compression, the lower the image
quality. Any lost image quality data cannot be restored and the
quality deteriorates each time the data is saved. The TIFF format
is recommended when modification and retouching are required.

Multi-TIFF
(*.TIF)

A TIFF format where multiple pages are saved to the same file.
You can also edit the scanned images before saving them. See
Epson Scan Help for details. To open Multi-TIFF files, you need a
program that supports it.

PDF (*.PDF)

A document format that can be read on both Windows and
Macintosh systems (platform independent). To use PDF
documents in Windows, you need Adobe Reader or Acrobat. Multipage documents can be saved as one PDF file. When you save
color or grayscale images in PDF, you can select a compression
level. You can also edit the scanned images before they are
saved. See Scanning Directly to a PDF File for details.

PICT (*.
PCT)
(Macintosh
only)

A standard image file format for Macintosh. Most Macintosh
programs, including word processing programs, can read images
in this format.

PRINT
Image
Matching II
JPEG (*.
JPG) or
TIFF (*.TIF)

A file format that includes PRINT Image Matching II data for
enhanced quality and a wider color range. Print Image Matching
II compatible printers can then print this data for brilliant, true-tolife results. (PRINT Image Matching data does not affect the way
the image displays on the screen.) Available in JPEG or TIFF
format.

TIFF (*.TIF)

A file format created for exchanging data between many
programs, such as graphic and DTP software. When scanning
black & white images, you can specify the compression type.

The checkboxes at the bottom of the window give you these options.
Overwrite any files with the same name
Select this option if you want to reuse the selected file name and location and
overwrite previous files with the same names.
Show this dialog box before next scan
Select this option if you want the File Save Settings window to appear automatically
before you scan (Home or Professional Mode only). If you deselect it, you must click
the

File Save Settings button to open the window in Home or Professional Mode.

Open image folder after scanning

Select this option if you want Windows Explorer or the Macintosh Finder to
automatically open the folder where your scanned image is saved when Epson Scan
finishes scanning.
Click OK.
In Full Auto Mode, click OK again, then click Scan. In Home or Professional Mode, click
Preview, then click Scan.
The scanned image is automatically saved in the file and location you chose.
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Using Full Auto Mode
When you start Epson Scan for the first time, it runs in Full Auto Mode and displays the Epson
Scan standby window.

Note:

In Full Auto Mode, you can scan only 35mm color negative film strips or color
positive slides. To scan other types of film, use Home or Professional Mode.

If you want to select a custom resolution, restore faded colors, or remove dust marks, click
the Customize button. You see the Customize window.

Note:

If you started scanning from a program like Adobe Photoshop Elements, the File
Save Settings button is not available in the Customize window.

Select your settings and click OK. (For details on selecting settings, click the Help button.)
Click the Scan button. Epson Scan starts scanning in Full Auto Mode.
Epson Scan previews each image in your film strip or each slide, detects whether it is color
positive or color negative, and selects the scan settings automatically. After a moment,
you see a small preview of each image in the Epson Scan window. (It takes a few minutes
to scan a full film strip.)

Note:

If you need to change any settings, click the Pause button. You will return
to the Epson Scan standby window.
If you need to cancel scanning, click the Cancel button when it appears.

Depending on how you started Epson Scan, the program saves the files to the location you
specified or opens the scanned image in your scanning program. See Finishing the Scan for
details.

Note:

If you have a problem scanning your film or slides in Full Auto Mode, try
scanning them in Home or Professional Mode instead.
If you want to change the scan mode, see Changing the Scan Mode.
If your image is not rotated correctly, see Images Are Rotated Incorrectly.
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Changing the Scan Mode
To change the scan mode, click the arrow in the Mode box in the upper right corner of the Epson
Scan window. Then select the mode you want to use from the list that appears.

Note:

The mode you select remains in effect when you start Epson Scan the next time.

For instructions on scanning using these modes, see:
Full Auto Mode: Using Full Auto Mode.
Home or Professional Mode: Selecting Basic Settings.
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Selecting Basic Settings
When you start Epson Scan in Home or Professional Mode, you see the main Epson Scan window.
Home Mode

Professional Mode

Before you scan your film or slides, you need to select these basic settings.

Original settings. These tell Epson Scan the type of film or slides you are scanning.
Destination settings. These tell Epson Scan how you plan to use your scanned images.
Follow these steps to select the basic settings for film or slides in Epson Scan.
Do one of the following to select your document type.
Home mode:
Click the arrow to open the Document Type list and select the type of film or slide(s) you
are scanning. Select Color Negative Film, B&W Negative Film, or Positive Film for a
film strip, or Positive Film for slides. Then click the Color, Grayscale, or Black&White
button to match the colors in the original, if necessary.
Professional mode:
Click the arrow to open the Document Type list and select Film (for scanning film or
slides). Then click the arrow in the Film Type list and select Color Negative Film, B&W
Negative Film, or Positive Film for a film strip, or Positive Film for slides.
Do one of the following to select your destination setting(s).
Home mode:
In the Destination box, click the button for the way you plan to use the scanned images.
Screen/Web for images you will view only on a computer screen or post on the
web.
Printer for images you will be printing.
Other if you want to select a specific resolution for other purposes.
Professional mode:
Click the arrow to open the Image Type list and select the image type you are scanning.
Image Type
setting

Type of image you are scanning

48-bit Color

Color photo that you may want to modify in a 48-bit imageediting program
If you use this setting, your image file size will be
significantly larger than if you use the 24-bit Color or Color
Smoothing settings.

24-bit Color

Color photo

Color Smoothing Color graphics, such as a chart or graph
16-bit Grayscale

Black-and-white photo with many shades of gray
If you use this setting, your image file size will be larger than
if you use the 8-bit Grayscale setting.

8-bit Grayscale

Black-and-white photo with just a few shades of gray

Black & White

Black-and-white positive film or slides

In Home Mode, Epson Scan selects a default resolution setting based on the Destination
setting you select. See Selecting the Scan Resolution to continue scanning.
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Selecting the Scan Resolution
In Home Mode, you can change the resolution only if you select Other as the Destination setting.

In Professional Mode, you can select the resolution you want at any time.

Before you select the scan resolution, you should consider whether you will enlarge your images
before or after you scan them. Follow these guidelines.
You will not be enlarging the images.
If you will scan the images at 100% size or smaller and will not enlarge them later, you
can accept the Resolution setting selected by Epson Scan based on your Destination
setting (Home Mode only).
You will enlarge the images as you scan them (increase the Target Size
setting).
If you will enlarge the images in Epson Scan so you can use them at a larger size, you
can accept the Resolution setting selected by Epson Scan based on your Destination
setting (Home Mode only).
You will scan the images at their original size, but then enlarge them later in
an image-editing program.
If you plan to enlarge your images later in an image-editing program, you need to
increase the Resolution setting to retain a high image quality after enlargement.
Increase the resolution by the same amount you will increase the image size. For
example, if the resolution is 300 dpi (dots per inch), but you will increase the image size
to 200% in an image-editing program, change the Resolution setting to 600 dpi in
Epson Scan.

Click the arrow next to the Resolution list and select the number of dots per inch at which you
want to scan. See the table below for some guidelines.
What you will do with
the scanned image

Suggested scan resolution

Send via e-mail, upload to
web, view only on the
screen

96 to 150 dpi

Print

300 dpi

Fax

200 dpi

Enlarge after scanning at
100%

Increase Resolution setting by same amount you will
increase image size after scanning

After selecting the Resolution, you can preview your images and make any necessary
adjustments. See Previewing and Adjusting the Scan Area to continue scanning.
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Previewing and Adjusting the Scan Area
Once you have selected your basic settings and resolution in Home or Professional Mode, you
can preview your images and select or adjust the area of the images you want to scan. Epson
Scan displays the preview images in a separate Preview window on your screen.
There are two types of preview.
Normal preview displays your previewed images in their entirety. You must select the
scan area and make any image quality adjustments manually.
Thumbnail preview displays your previewed images as thumbnails. Epson Scan
automatically locates the edges of your scan area and applies automatic exposure
settings to the images. This is the default preview type when scanning film or slides.
Note:

If you are scanning negative slides, you must use the normal preview.

Follow these steps to preview your images in Home or Professional Mode.
Click the Preview button toward the bottom of the Epson Scan window. If you want to
change the preview type, click the Thumbnail checkbox under the Preview button, if it is
available.

Epson Scan prescans your images and displays them in one of the following Preview
windows.
Normal preview

Thumbnail preview

If you are viewing the normal preview, you can do the following to adjust the image(s).
To select your scan area, draw a marquee that marks the edges of the scan area on
each image. You can move and resize the marquees to change the scan areas as
necessary. See Adjusting the Scan Area (Marquee) for instructions.
Note:

If you are going to scan at a different size than your original, you must first
select your Target Size and automatically create a marquee that is
proportioned to that size. See Selecting the Scan Size for instructions. You
can then copy the marquee and place it on each image you will scan at that
size.

To zoom in on an image, click inside the scan area and click the Zoom button.
Epson Scan prescans again and displays a larger preview on the Zoom tab. (Your
other images are still previewed at the original size on the Preview tab.)
To adjust the image quality, click the image(s) you want to modify and make the
adjustments as described in Adjusting the Color and Other Image Settings.
If you are viewing the thumbnail preview, you can do the following to adjust the image(s).
To zoom in on an image, double-click its thumbnail, or click the thumbnail and then
click the Full Size tab near the top of the Preview window. (This feature is only
available when you are scanning multiple images at the same time.)
To rotate an image or flip it horizontally (like a mirror image), click its thumbnail and
then click the

rotation icon or

mirroring icon.

To adjust the scan area to crop your image, you can create and move a marquee
that marks the edges of your scan. See Adjusting the Scan Area (Marquee) for
instructions.
To adjust the image quality, click the image(s) you want to modify and make the
adjustments as described in Adjusting the Color and Other Image Settings. If you
want to apply the adjustments to all your images, click the All button.
Note:

If your image is not rotated correctly, see Images Are Rotated Incorrectly.

When you have finished adjusting the scan areas, and modifying the color and image
settings, you can select the size of your scanned image, if you have not already selected it.
See Selecting the Scan Size for instructions.

Adjusting the Scan Area (Marquee)
A marquee is a moving dotted line that appears on the edges of your preview image to indicate
the scan area.

You can move the marquee, adjust its size, and create multiple marquees on one image (normal
preview only) to scan different image areas in separate scan files. Follow these steps.
Note for Home Mode users:

When you use the Thumbnail preview with film or slides, Epson Scan automatically
creates marquees around your image(s) for you. If you need to adjust a marquee,
click inside it and click the
delete marquee icon before completing the steps in
this section. If you do not need to adjust any marquees, skip to Adjusting the
Color and Other Image Settings.

To draw a marquee, move your cursor over a preview image. The pointer becomes a set of
cross-hairs.
Position the pointer in the area where you want to place the corner of your marquee and
click. Hold down the mouse button and drag the cross-hairs over the image to the opposite
corner of the desired scan area. Then release the mouse button. You see the moving
dotted line of the marquee.

Do one of the following to adjust the marquee.
To move the marquee, position your cursor inside the marquee. The pointer
becomes a hand. Click and drag the marquee to the desired location.

To resize the marquee, position your cursor over the edge or corner of the marquee.
The pointer becomes a straight or angled double-arrow. Click and drag the edge or
corner to the desired size.

Note:

To restrict movement of the marquee to vertical or horizontal only, hold
down the Shift key as you move the marquee. To restrict sizing of the
marquee to the current proportions, hold down the Shift key as you resize
the marquee.
For best results and image exposure, make sure all sides of the marquee
are located inside the preview image. Do not include any of the area around
the preview image in the marquee.

To draw multiple marquees (up to 50; normal preview only), you can just draw them as
copy marquee icon to create additional
described in steps 1 through 3, or click the
marquees of the same size. You can move and resize all the marquees as described in step
3. To delete a marquee, click inside it and click the

delete marquee icon.

Note:

If you draw multiple marquees, make sure you click the All button in the
Preview window before you scan; otherwise, only the area inside of the last
marquee you drew will be scanned.
If you are scanning multiple slides or images in a film strip using the Normal
preview, you must draw a separate marquee over each image in order to
scan the images as separate files.
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Adjusting the Color and Other Image Settings

Once you have previewed your images and adjusted the scan area, you can modify the image
quality, if necessary. Epson Scan offers a variety of settings for improving color, sharpness,
contrast, and other aspects affecting image quality.
Before you make adjustments, be sure to click the image or marquee for the area you want to
adjust. In Professional Mode, you may need to scroll down to the Adjustments area of the main
Epson Scan window.

The table below describes the settings available in Home and/or Professional Mode. For details
on adjusting these settings, click Help in the Epson Scan window.
When you are finished making adjustments, you can size your scanned images (see Selecting
the Scan Size) or go ahead and scan (see Finishing the Scan).
Setting

Available mode(s) and description

Color Restoration

Home and Professional:
Restores the colors in faded photos automatically.

Dust Removal

Professional only:
Removes dust marks from your originals automatically. The
results of Dust Removal do not appear in the preview, only in
your scanned image. The level of Dust Removal is adjustable.

Backlight
Correction

Home and Professional:
Removes shadows from photos that have too much background
light. In Professional Mode, the level of Backlight Correction is
adjustable.

Grain Reduction

Professional only:
Reduces the effect of surface roughness from film and slide
images. The level of grain reduction is adjustable.

Digital ICE
Technology and
Digital ICE Lite
Technology

Home and Professional:
Removes dust or scratch marks from color film or slide images.
Digital ICE Technology is a hardware-based dust removal
method that is more accurate than the Dust Removal feature,
but it is slower and requires more system resources. Digital ICE
Lite Technology is available in Professional Mode only.

Brightness

Home and Professional:
Adjusts the overall image lightness and darkness.
In Home Mode, click the Brightness button to access the
Brightness setting.
In Professional Mode, click the
access the Brightness setting.

Contrast

Home and Professional:
Adjusts the difference between the light and dark areas of the
overall image.
In Home Mode, click the Brightness button to access the
Contrast setting.
In Professional Mode, click the
access the Contrast setting.

Saturation

Image Adjustment button to

Professional only:
Adjusts the density of colors in the overall image.
Click the
setting.

Color Balance

Image Adjustment button to

Image Adjustment button to access the Saturation

Professional only:
Adjusts the balance of red, green, and blue colors in the overall
image.
Image Adjustment button to access the Color
Click the
Balance setting.

Auto Exposure

Home: Automatically applied.
Professional: Automatically applied. To adjust the level of
exposure, click the Configuration button, click the Color tab,
and adjust the Auto Exposure Level slider.
If you don't want Auto Exposure automatically applied, deselect
Continuous Auto Exposure in the Color tab. Then, click the
Auto Exposure button (Professional Mode only) or reselect
Continuous Auto Exposure whenever you want to apply this
setting to an image.

Unsharp Mask

Home: Automatically applied.
Professional: Turned on by default. Unsharp Mask makes the
edges of image areas clearer for an overall sharper image. The
level of sharpness is adjustable. Turn off to leave softer edges.

Histogram

Professional only:
Provides a graphical interface for adjusting highlight, shadow,
and gamma levels individually. For advanced users only.
Histogram Adjustment button to access the
Click the
Histogram setting.

Tone Correction

Professional only:
Provides a graphical interface for adjusting tone levels
individually. For advanced users only.
Tone Correction button to access the Tone
Click the
Correction setting.

Color Palette

Professional only:
Provides a graphical interface for adjusting mid-tone levels, such
as skin tones, without affecting the highlight and shadow areas
of the image. For advanced users only.
Color Palette button to use the Color Palette
Click the
settings. See Using the Color Palette Function (Professional
Mode Only) for instructions.

Threshold

Home and Professional:
Adjusts the level at which the black areas in text and line art are
delineated, improving text recognition in OCR programs.
(Available only when you select Positive Film as the Document
Type or Film Type setting and Black & White as the Image
Type setting.)
In Home Mode, click the Brightness button to access the
Threshold setting.

Note:

To view the red, green, and blue levels at particular points in your preview
densitometer icon in the
image as you make adjustments, click the
preview window and click an image area. See Epson Scan help for details.
Certain settings may not be available, or may be automatically selected,
depending on the type of image you are previewing and other settings you
have selected.
You can customize how certain Epson Scan settings behave by clicking the
Configuration button and changing settings in the window that appears.
See Epson Scan Help for details.
To undo any image quality adjustments you make to the preview image,
click the Reset button (if available), turn off the setting, or preview your
image again.
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Selecting the Scan Size
You can scan your images at their original size, or you can reduce or enlarge their size as you
scan them. You do this using the Target Size setting in Home or Professional Mode.
Home Mode

Professional Mode

If you are going to scan your image to a particular size, you should select the Target Size setting
after previewing it, but before adjusting your scan area (indicated by the marquee). This sets
the scan area to the correct proportions so your image will not be cropped unexpectedly.
For instructions on previewing your images, see Previewing and Adjusting the Scan Area. Then
follow these steps to select the Target Size setting.
Note for Home Mode users:

When you use the Thumbnail preview with film or slides, Epson Scan automatically
selects a target size of 4 × 6 in. for you. If you need to select a different target
size, complete all of the steps in this section. If you do not need to adjust any
target sizes, go to step 5.

You can choose a predefined scan size from the Target Size list. Click the arrow in the list
and select the size you want. A marquee (dotted line) proportioned for that size appears
on your preview image.

If you need to create a scan size that is not in the Target Size list, you can create a custom
size. Click the arrow in the list and select Customize. You see the Target Size window.

Type a name for your custom size, enter the size, click the Save button, then click OK.
Your new size appears in the Target Size list.
In Professional Mode, you can fine-tune the size using additional tools. Click the +
(Windows) or

(Mac OS X) next to Target Size to display these tools.

To size your image by a certain percentage, adjust the Scale value.
To change the way your image is cropped, turn Trimming on or off. (See Epson
Scan Help for details.)
To unlock the proportions of your scan size, click the
marquee or enter new width/height measurements.

lock icon. Then adjust the

Once you have selected your scan size, you can click and drag the marquee to the area in
the image you want to scan. For details, see Adjusting the Scan Area (Marquee). The
marquee proportions are retained as you adjust it.

If you need to rotate the marquee for a landscape or portrait image without changing its
aspect ratio, click the
Original Target Size.)

orientation icon. (Not available if you are scanning at the

Note:

For more information about using the Target Size tools, click Help in the Epson
Scan window.

Now you are ready to scan your images. Click the Scan button, and see Finishing the Scan
for instructions.
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Finishing the Scan
What happens after you scan depends on how you started your scan.
Start button or running Epson Scan as a
If you started your scan by pressing the
standalone program and you used Full Auto Mode, your scanned image is saved in the
file format and location you chose. If you did not choose any file save settings, it is
saved as a JPEG file in the Pictures or My Pictures folder.
Start button or running Epson Scan as a
If you started your scan by pressing the
standalone program and you used Home or Professional Mode, you see the File Save
Settings window. This lets you select the name and location of your saved scan files.
See Selecting File Save Settings for details.
If you started your scan from a scanning program such as Adobe Photoshop Elements,
your scanned images open in the program window. If Epson Scan does not
automatically close after scanning, click Close to close the Epson Scan window and view
your images in the program.
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Home > Scanning Special Projects

Restoring Color
Using the Color Palette Function (Professional Mode Only)
Using the Color Restoration feature in Epson Scan, you can transform old, faded, or badly
exposed photos into ones with true-to-life color and sharpness. You can restore printed photos,
film, or slides automatically as you scan them.
Original image

Color Restoration applied

Follow these steps to restore colors using Epson Scan.
Place your original. See one of these sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Start Epson Scan. See one of these sections for instructions.
Documents or photos:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Film or slides:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program

When the Epson Scan window appears, do one of the following, depending on the currently
selected scan mode.
Home or Professional Mode: Go to step 4.
Full Auto Mode: Click the Customize button, then click the Specify document
type for Full Auto Mode checkbox and select the type of original you are scanning,
if necessary. Then click the Color Restoration checkbox and click OK. Continue
with step 9.

Note:

For details on using Full Auto Mode when scanning photos, see Using Full
Auto Mode. For details on using Full Auto Mode when scanning film or
slides, see Using Full Auto Mode.
In Full Auto Mode, you can only scan 35mm color negative film strips or
color positive slides. To scan other types of film, use Home or Professional
Mode.
To change the scan mode when scanning documents or photos, see
Changing the Scan Mode. To change the scan mode when scanning film or
slides, see Changing the Scan Mode.

Select the basic settings for the type of original(s) you are scanning, then select the
destination setting for the way you will use your image(s). See one of these sections for
instructions.
Documents or photos: Selecting Basic Settings
Film or slides: Selecting Basic Settings
Click the Preview button to preview your image(s), then select your scan area. See one of
these sections for instructions.
Documents or photos: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Do one of the following to select the Color Restoration option.
Home Mode: Click the Color Restoration checkbox.

Professional Mode: Scroll down to the Adjustments area and click the Color
Restoration checkbox.

Make any other necessary image adjustments. See one of these sections for
instructions.
Documents or photos: Adjusting the Color and Other Image Settings
Film or slides: Adjusting the Color and Other Image Settings
Size your image as necessary. See one of these sections for instructions.
Documents or photos: Selecting the Scan Size
Film or slides: Selecting the Scan Size
Click the Scan button to scan and restore the color in your image(s).
What happens next depends on how you started Epson Scan. See one of these sections for
details.
Documents or photos: Finishing the Scan
Film or slides: Finishing the Scan

Using the Color Palette Function (Professional Mode Only)
Follow the steps in these sections to fine tune the colors in your images using the Color Palette
feature in Epson Scan.

Sampling a Color From an Image

If necessary, click the Preview button to preview your image. Then click the
Palette button.
The Color Palette window appears.

Color

Click the

Color Extractor button. Your cursor changes to an eye dropper.

In the Preview window, click on the color in your image that needs adjustment.
The color you selected is moved to the center cell in the Color Palette window with
variations in hue in the surrounding cells.
Select the cell that contains the hue you would like to use to adjust the color in your
image. This color now becomes the color of the center cell and the color change is reflected
in your image.
Note:

You can also use the cells to the right of the adjustment area to change the
brightness, if necessary.

If you want to continue adjusting the color, repeat step 4.

If you want to save the color for future scans, click the
appears in the save area.

Save button. The color

Note:

To load a previously saved color, select the color and click the
Palette button.

Apply to

When you are finished adjusting the color, click the Close button to return to the Epson
Scan window.
For further details on using the Color Palette feature, click the Help button.

Applying a Color to an Image

If necessary, click the Preview button to preview your image. Then click the
Palette button.
The Color Palette window appears.

Color

Select the cell that contains the hue you would like to use to adjust the color in your
image. This color now becomes the color of the center cell.
Note:

You can also use the cells to the right of the adjustment area to change the
brightness, if necessary.

Click the

Color Applicator button. Your cursor changes to a droplet.

In the Preview window, click on the color in your image that needs adjustment. The color
change is reflected in your image.

If you want to continue adjusting the color, repeat steps 2 through 4.

If you want to save the color for future scans, click the
appears in the save area.

Save button. The color

Note:

To load a previously saved color, select the color and click the
Palette button.

Apply to

When you are finished adjusting the color, click the Close button to return to the Epson
Scan window.
For further details on using the Color Palette feature, click the Help button.
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Removing Dust Marks
Using the Dust Removal feature in Epson Scan, you can virtually “clean” the dust marks from
your originals as you scan them.
Original image

Dust Removal applied

Note:

Before scanning your originals, carefully remove any dust that you can see
on them.
When you scan film or slides, the Dust Removal feature is available for Full
Auto Mode or Professional Mode only (it is not available for Home Mode). To
remove dust marks from color film or slides in Home Mode, use the Digital
ICE Technology feature as described in Removing Dust and Scratch Marks
from Film and Slides Using Digital ICE Technology.
Do not use Dust Removal to scan film or slides that do not contain dust or
scratch marks; otherwise your scanned image may be distorted or blurred.
For more accurate, hardware-based dust or scratch removal from your color
film or slides, you can use the Digital ICE Technology feature. See
Removing Dust and Scratch Marks from Film and Slides Using Digital ICE
Technology for details.

Follow these steps to remove dust marks using Epson Scan.
Place your original on the scanner. See one of these sections for instructions.
Documents or photos: Placing Documents or Photos

Film or slides: Placing Film or Slides
Start Epson Scan. See one of these sections for instructions.
Documents or photos:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Film or slides:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
When the Epson Scan window appears, do one of the following, depending on the currently
selected scan mode.
Home Mode and Professional Mode: Go to step 4.
Full Auto Mode: Click the Customize button, then click the Specify document
type for Full Auto Mode checkbox and select the type of original, if necessary.
Then click the Dust Removal checkbox and click OK. Continue with step 9.

Note:

For details on using Full Auto Mode when scanning documents or photos,
see Using Full Auto Mode. For details on using Full Auto Mode when
scanning film or slides, see Using Full Auto Mode.
In Full Auto Mode, you can only scan 35mm color negative film strips or
color positive slides. To scan other types of film, use Home or Professional
Mode.
To change the scan mode when scanning documents or photos, see
Changing the Scan Mode. To change the scan mode when scanning film or
slides, see Changing the Scan Mode.

Select the basic settings for the type of your original(s), then select the destination setting
for the way you will use your image(s). See one of these sections for instructions.
Documents or photos: Selecting Basic Settings
Film or slides: Selecting Basic Settings

Click the Preview button to preview your image(s), then select your scan area. See one of
these sections for instructions.
Documents or photos: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Do one of the following to select the Dust Removal option.
Home Mode: Click the Dust Removal checkbox.
Professional Mode: Scroll down to the Adjustments area and click the Dust
Removal checkbox. If you want to increase or decrease the level of the dust
removal effect, click the + (Windows) or
and select a setting in the Level list.
Home Mode:

(Mac OS X) button next to the option

Professional Mode:

Note:

You can reduce the appearance of surface roughness in your film or slide(s)
by clicking the Grain Reduction checkbox. Click the + (Windows) or
(Mac OS X) button and select a Level setting to adjust its effect, if
necessary.
The result of the dust removal does not appear in the image in the Preview
window. You must scan the image first.

Make any other necessary image adjustments. See one of these sections for instructions.
Documents or photos: Adjusting the Color and Other Image Settings
Film or slides: Adjusting the Color and Other Image Settings
Size your image as necessary. See one of these sections for
instructions.
Documents or photos: Selecting the Scan Size
Film or slides: Selecting the Scan Size
Click the Scan button to scan and remove dust marks in your image(s).
What happens next depends on how you started Epson Scan. See one of these sections for
details.
Documents or photos: Finishing the Scan
Film or slides: Finishing the Scan
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Removing Dust and Scratch Marks from Film and Slides Using
Digital ICE Technology
Digital ICE Technology Specifications
Your scanner and its Epson Scan software are equipped with the Digital ICE Technology and
Digital ICE Lite Technology features that remove dust or scratch marks from color film or slides.
Original image

Digital ICE Technology applied

Digital ICE Technology is a hardware-based dust removal method that is more accurate than the
Dust Removal feature. Digital ICE Technology can remove dust or scratch marks without
affecting the image composition. However, it takes longer to scan using Digital ICE Technology
and also uses more of your system resources. For faster (but less accurate) dust removal, try
removing dust marks using the Dust Removal feature. See Removing Dust Marks for details.
Note:

Digital ICE Technology is not available in Full Auto Mode.
You cannot use Dust Removal and Digital ICE Technology at the same time.
When you scan film or slides, the Dust Removal feature is available for Full
Auto Mode or Professional Mode only (it is not available for Home Mode). To
remove dust marks from color film or slides in Home Mode, you must use
the Digital ICE Technology feature.

You can use Dust Removal or Digital ICE Technology on the following types of film or slides:
Film type

Dust Removal

Digital ICE
Technology

Color negative film

Yes

Yes

Color positive film or slides

Yes

Yes *

Monochrome negative film

Yes

No **

Monochrome positive film or slides

Yes

No

* Kodachrome film is not supported.
** Only chromogenic monochrome negative film is supported.
Before using Digital ICE Technology, make sure your system meets the requirements in Digital
ICE Technology Specifications.
Follow these steps to remove dust or scratch marks from film or slides using Epson Scan’s Home
or Professional Mode:
Place your original film strip or slide(s) on the scanner. See Placing Film or Slides.
Start Epson Scan. See one of these sections for instructions:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
When the Epson Scan window appears, set the scan mode to Home Mode or
Professional Mode. Then select the basic settings for your film strip or slide(s) and select
the destination setting for the way you will use your image(s). See Selecting Basic Settings
for instructions.
Click the Preview button to preview your images, then select your scan area. See
Previewing and Adjusting the Scan Area for instructions.
Do one of the following to select the Digital ICE Technology option:
Home Mode: Click the DIGITAL ICE Technology checkbox.
Professional Mode: Scroll down to the Adjustments area and click the DIGITAL
ICE Technology checkbox. If you want to decrease the level of the Digital ICE
Technology correction effect, click the + (Windows) or
(Macintosh) button next
to the option and select the DIGITAL ICE Lite Technology setting in the Mode list.
Home Mode:

Professional Mode:

Note:

The results of Digital ICE Technology do not appear in the images in the Preview
window, but apply to all of them. You must scan the images to see the effects.

Make any other necessary image adjustments. See Adjusting the Color and Other Image
Settings for instructions.
Size your image as necessary. See Selecting the Scan Size for instructions.
Click the Scan button to scan and remove dust and scratch marks in your image(s).
What happens next depends on how you started Epson Scan. See Finishing the Scan for
details.

Digital ICE Technology Specifications
To use Digital ICE Technology, your system memory and hard disk space must meet the
requirements in the table below. Digital ICE Technology needs additional resources to process
and store your scanned images at the sizes and resolutions specified here.
Film or slide type

Resolution *

Hard disk
space

System
memory

35mm film or slide

150 dpi

1MB

8MB

300 dpi

1MB

15MB

600 dpi

4MB

30MB

1200 dpi

16MB

59MB

2400 dpi

63MB

117MB

3600 dpi

142MB

175MB

12800 dpi

251MB

233MB

150 dpi

4MB

34MB

300 dpi

8MB

70MB

600 dpi

29MB

139MB

1200 dpi

116MB

277MB

2400 dpi

464MB

553MB

3600 dpi

1042MB

830MB

12800 dpi

1853MB

1106MB

Medium format film (6 × 12
cm)

* This is the actual scan resolution used by Digital ICE Technology, which is higher than

the scan resolution you specify in Epson Scan. Make sure your system resources meet
these increased requirements.
Note:

It may take much longer to scan and for your software to respond to clicking the
Cancel button if you have insufficient system resources.
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Fixing Backlit Photos
Using the Backlight Correction feature in Epson Scan, you can remove shadows from photos
that have too much background light. You can fix printed photos, film, or slides automatically as
you scan them.
Note:

Backlight Correction is not available in Full Auto Mode.

Original image

Backlight Correction applied

Follow these steps to fix backlit photos using Epson Scan.
Place your original. See one of these sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Start Epson Scan. See one of these sections for instructions.
Documents or photos:
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Film or slides:

Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
When the Epson Scan window appears, set the scan mode to Home Mode or
Professional Mode. Then select the basic settings for the type of original(s) you are
scanning and select the destination setting for the way you will use your image(s). See one
of these sections for instructions.
Documents or photos: Selecting Basic Settings
Film or slides: Selecting Basic Settings
Click the Preview button to preview your image(s), then select your scan area. See one of
these sections for instructions.
Documents or photos: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Do one of the following to select the Backlight Correction option.
Home Mode: Click the Backlight Correction checkbox.

Professional Mode: Scroll down to the Adjustments area and click the Backlight
Correction checkbox. If you want to increase or decrease the level of the backlight
correction effect, click the + (Windows) or
and select a setting in the Level list.

(Mac OS X) button next to the option

Make any other necessary image adjustments. See one of these sections for
instructions.
Documents or photos: Adjusting the Color and Other Image Settings
Film or slides: Adjusting the Color and Other Image Settings
Size your image as necessary. See one of these sections for instructions.
Documents or photos: Selecting the Scan Size
Film or slides: Selecting the Scan Size
Click the Scan button to scan and correct backlighting in your image(s).
What happens next depends on how you started Epson Scan. See one of these sections for
details.
Documents or photos: Finishing the Scan
Film or slides: Finishing the Scan
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Using the Scanner as a Copier
You can use your scanner along with a printer connected to your computer just like you would
use a copy machine. You can even enlarge and reduce, restore faded colors, remove dust,
enhance text, and adjust image brightness and contrast as you copy.
Place your original on the scanner. See one of these sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Start the Epson Copy Utility in one of these ways.
Press the

Copy button on the scanner.

Windows: Select
> Copy Utility.

or Start > All Programs or Programs > Epson Software

Mac OS X: Open the Applications > Epson Software > Copy Utility folders and
double-click the Copy Utility icon.
You see the Copy Utility window.

Select your scanner from the Scanner list at the top of the window, if necessary.
Select your printer from the Printer list, if necessary.
Click the Source Type box, select the type of document you are copying, and click OK.
See the table below for guidance.

Source Type setting

Type of document

Color Document
(Single Page)

One-page color document containing text or text and
graphics, such as a flyer

Black & White
Document (Single
Page)

One-page black and white document containing text or
text and graphics, such as a letter

Color Document
(Multiple Pages)

Multiple page color document containing text or text
and graphics, such as a brochure

Black & White
Document (Multiple
Pages)

Multiple page black and white document containing
text or text and graphics, such as a manual

Photo

Color or black-and-white photographs

Negative Film

Color negative film strip

Positive Film

Color slides or positive film strip

Click the Output Paper box, select the type and size of paper you loaded in your printer,
and click OK.
Note:

If you are printing on certain Epson printers, you see the printer settings window.
See your printer documentation for instructions on selecting settings.

If you want to enlarge or reduce your image as you copy it, click the Copy Size box, select
the enlargement/reduction, and click OK.
Note:

If you are printing on an Epson printer that supports borderless printing, you can
select options for Margins (borders) or No Margins (borderless).

If you are copying a faded photo and want to restore the colors, click the Color
Restoration checkbox. It is available only when the Source Type is Photo, Negative
Film, or Positive Film.
If you need to remove dust marks as you copy, click the Dust Removal checkbox. It is
available only when the Source Type is Negative Film or Positive Film.
If you are copying a color or black-and-white document, you can improve the definition of
text and line art by leaving the Text Enhancement checkbox checked. It is available only
when the Source Type is one of the Document options.
If you need to adjust the lightness or darkness of your original or adjust the contrast
between them as you copy, click the slider beneath the Brightness and/or Contrast
settings. Contrast is only adjustable when the Source Type is Photo, Negative Film, or
Positive Film.
Click the arrow in the Number of Copies box to select the number of copies you want, if
necessary.
When you are ready to scan and print, click the Copy button.

Note:

If you want to preview your scan before printing it or select additional copy
settings, click the Preview/Custom button at the bottom of the window. Click
Help in the Copy Utility for instructions on using the Custom Copy features.
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Scanning Directly to a PDF File
Starting a Scan With the Scan to PDF Button
Starting a Scan With Epson Scan (Full Auto Mode)
Starting a Scan With Epson Scan (Home/Office/Professional Mode)

Starting a Scan With the Scan to PDF Button
You can scan multiple document pages or photos and save them as one PDF file on your
computer using the scanner’s

Scan to PDF button.

Note:

In Windows, you need Adobe Reader or Acrobat to view PDF files. You can
download Adobe Reader for free from Adobe’s website.

Place the first page of your original document (or your photos). See Placing Documents or
Photos for instructions.
Press the
window.

Scan to PDF button on the scanner. You see the Scan to PDF

Click the Settings button. You see the Scan to PDF Settings window.

Click the Color, Grayscale, or Black&White button to match the colors in the original.
Click the arrow to open the Size list and select the size of your original.
If you need to select a size that is not in the Size list, you can create a custom size. Click
the arrow in the Size list and select Customize. You see the Source Size window.

Type a name for your custom size, enter the size, click the Save button, then click OK.
Your new size appears in the Size list.
Click the arrow next to the Resolution list and select the number of dots per inch at which
you want to scan. See the table below for guidelines.

What you will do with the scanned
image

Suggested scan resolution

Send via e-mail, upload to web, view
only on the screen

96 to 150 dpi

Print

300 dpi

Use the settings in the Image Adjustments area of the window to modify the image quality
if necessary. See the table below for guidelines.

Setting

Description

Brightness

Adjusts the overall image lightness and darkness.

Contrast

Adjusts the difference between the light and dark
areas of the overall image.

Unsharp Mask

Turn on to make the edges of image areas clearer
for an overall sharper image. Turn off to leave
softer edges.

Descreening

Removes the rippled pattern that can appear in
subtly shaded image areas, such as skin tones. Also
improves results when scanning magazine or
newspaper images that include screening in their
original print process.

Text Enhancement

Improves the definition of text and line art.
Enhances text recognition when scanning text
documents.

Threshold

Adjusts the level at which the black areas in text
and line art are delineated. (Available only when
you select Black&White as the Image Type
setting.)

Image Option > Auto
Area Segmentation

Makes grayscale images clearer and text
recognition more accurate by scanning text in black
& white while retaining the grayscale of the image.
(Available only when you select Black&White as
the Image Type setting.)

Image Option > Dropout

Drops out the color you select (red, green, or blue)
from the scan. (Available only when you select
Grayscale or Black&White as the Image Type
setting.)

Image Option > Color
Enhance

Enhances the color you select (red, green, or blue)
in the scan. (Available only when you select
Grayscale or Black&White as the Image Type
setting.)

Click the File save settings button. The File Save Settings window appears. The current
PDF settings are displayed.

If you need to change any of the current PDF settings, click the Options button. You see
the Epson PDF Plug-in Settings window.

Select the settings that match your document. If you want to create a searchable PDF,
make sure Create searchable PDF is selected in the Text tab (for details on selecting
settings and other PDF options, click the Help button). When you are finished selecting
settings, click OK. You return to the File Save Settings window.
Click OK again, click Close, then click Scan or press the
Epson Scan scans your page.

Start button on the scanner.

If you are scanning multiple pages, replace the first page on the document table with the
second page and click Scan or press the
page in your document.

Start button again. Repeat this step for each

When you are finished, click Finish or press the
Scan to PDF button on the scanner.
Your document is saved as a PDF file in the Pictures or My Pictures folder.
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Starting a Scan With Epson Scan (Full Auto Mode)
Using Full Auto Mode, you can scan a document to a PDF file quickly and easily.
Note:

In Windows, you need Adobe Reader or Acrobat to view PDF files. You can
download Adobe Reader for free from Adobe’s website.

Place the first page of your original document (or your photos or film). See one of these
sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Start Epson Scan. See one of these sections for instructions.
Documents or photos: Starting a Scan With Epson Scan
Film or slides: Starting a Scan With Epson Scan
When the Epson Scan window appears, set the scan mode to Full Auto Mode. Then click
the Customize button.

Note:

To change the scan mode, see Changing the Scan Mode for documents and photos
or Changing the Scan Mode for film and slides.

The Customize window
appears.

Click the File Save Settings button.
The File Save Settings window appears.

Select PDF as the Type setting. The current PDF settings are displayed below it.
If you need to change any of the current PDF settings, click the Options button. You see
the Epson PDF Plug-in Settings window.

Select the settings that match your document. If you want to create a searchable PDF,
make sure Create searchable PDF is selected in the Text tab (for details on selecting
settings and other PDF options, click the Help button). When you are finished selecting
settings, click OK. You return to the File Save Settings window.
When you are finished selecting file settings, click OK. Click OK again to close the
Customize window.
Click the Scan button. Epson Scan starts scanning in Full Auto Mode.
Depending on how you started Epson Scan, the program saves the file to the location you
specified or opens the scanned image in your scanning program. See one of these sections
for details.

Documents or photos: Finishing the Scan
Film or slides: Finishing the Scan
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Starting a Scan With Epson Scan (Home/Office/Professional Mode)
You can scan multiple document pages, photos, film images (Home/Professional Mode only), or
slides (Home/Professional Mode only) and save them as one PDF file on your computer using
Epson Scan.
Note:

In Windows, you need Adobe Reader or Acrobat to view PDF files. You can
download Adobe Reader for free from Adobe’s website.

Place the first page of your original document (or your photos or film). See one of these
sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Start Epson Scan. See one of these sections for instructions.
Documents or photos: Starting a Scan With Epson Scan
Film or slides: Starting a Scan With Epson Scan
When the Epson Scan window appears, set the scan mode to Home Mode, Office Mode,
or Professional Mode. Then select the basic settings for the type of original(s) you are
scanning and select the destination setting for the way you will use your image(s).
Home or Professional Mode:
See one of these sections for instructions.
Documents or photos: Selecting Basic Settings
Film or slides: Selecting Basic Settings
Office Mode:
Click the Help button in the Epson Scan window for instructions.
Note:

To change the scan mode, see Changing the Scan Mode for documents and photos
or Changing the Scan Mode for film and slides.

Click the Preview button to preview your image(s), then select your scan area.
Home or Professional Mode:
See one of these sections for instructions.
Documents or photos: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Office Mode:
Click the Help button in the Epson Scan window for instructions.
When you are finished selecting settings and previewing, click the Scan button.
The File Save Settings window appears. Select PDF as the Type setting. The current PDF
settings are displayed below it.

If you need to change any of the current PDF settings, click the Options button. You see
the Epson PDF Plug-in Settings window.

Select the settings that match your document. If you want to create a searchable PDF,
make sure Create searchable PDF is selected in the Text tab (for details on selecting
settings and other PDF options, click the Help button). When you are finished selecting
settings, click OK. You return to the File Save Settings window.
When you are finished selecting file settings, click OK. Epson Scan scans your page and
displays this window.

If you are only scanning one document page, or you don’t need to edit your pages, click
Save File and go to step 12.
If you are scanning multiple pages, click Add Page, replace the first page on the
document table with the second page, and click Scan. Repeat this step for each page in
your document. When you are finished, click Edit Page and go to step 10.
You see the Editing Page window displaying thumbnail images of each scanned page.

You can use the tools below the main window to select, rotate, reorder, and delete pages
in your document. Click the Help button for details.

If you want to include all the document pages in your PDF file as they currently look, go to
step 11.
If you do not need to include some of the pages, click the

odd pages or

delete icon

pages icons, or click the individual pages you do not need. Then click the
to delete them.
If you want to rotate pages, click the pages or use the
all pages icon to select the pages. Then click the
or
to rotate them.

odd pages,
left or

even

even pages,
right rotate icon

Note:

The

delete icon is not available when all document pages are selected.

When you have finished editing your document pages, click OK. Your document is saved as
a PDF file in the Pictures or My Pictures folder and you return to the Epson Scan window.
Click Close to exit Epson Scan.
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Scanning Directly to an E-mail
You can scan using the
Scan to E-mail button and automatically attach scanned image file
(s) to an e-mail message.
Note:

Not all e-mail programs work with the Scan to E-mail button. See the Attach To
Email Read Me file for more information.

Place your original on the scanner. See one of these sections for instructions.
Documents or photos: Placing Documents or Photos
Film or slides: Placing Film or Slides
Press the
Scan to E-mail button on the scanner. Epson Scan starts in Full Auto Mode
and automatically scans your image as a JPEG file.
Note:

If you want to restore color in or remove dust from your images before scanning,
click the Pause button. Then click Customize, select your options, click OK and
click Scan to continue.

After scanning is finished, you see the Send File Via E-mail window.

Select the e-mail program you use in the Select E-mail Application list.
If you want to resize your image, choose an option under Select Photo Size.

Note:

The box at the bottom of the window displays information about the image file(s)
you are attaching to the e-mail message.

Click OK. Your e-mail program is opened and any scanned images you selected are
attached to a new e-mail message. (See your e-mail program Help if you need instructions
on sending your e-mail message.)
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Converting Scanned Documents Into Editable Text
You can scan a document and convert the text into data that you can edit with a word
processing program. This process is called OCR (Optical Character Recognition). To scan and use
OCR, you need to use an OCR program, such as the ABBYY FineReader program.
OCR software cannot recognize handwritten characters, and certain types of documents or text
are difficult for OCR software to recognize, such as:
Items that have been copied from other copies
Faxes
Text with tightly spaced characters or line pitch
Text that is in tables or underlined
Cursive or italic fonts, and font sizes less than 8 points
Follow these steps to scan and convert text using ABBYY FineReader.
Place your original document on the scanner. See Placing Documents or Photos for
instructions.
Do one of the following to start ABBYY FineReader.

Windows: Select
or Start > All Programs or Programs > ABBYY FineReader
6.0 Sprint > ABBYY FineReader 6.0 Sprint.
Mac OS X: Open the Applications > ABBYY FineReader 5 Sprint Plus folders and
double-click the Launch FineReader 5 Sprint icon.
You see the ABBYY FineReader window.

Click the Scan&Read icon at the top of the window. Epson Scan starts in the last mode
you used.
Note for Mac OS X users:

If you do not see a Scan&Read icon, choose Select Scanner from the Scan&Read
menu, select EPSON Perfection V500, and click OK. Then select Scan&Read
from the Scan&Read menu to start Epson Scan.

In Full Auto Mode, click Scan. Epson Scan prescans, scans, and processes the text
into editable format, then displays it in the FineReader window.
In Home Mode, select Magazine, Newspaper, or Text/Line Art as the Document
Type. Then select Black&White or Color as the Image Type, and choose Printer or
Other as your Destination setting. Preview and select your scan area as described in
Previewing and Adjusting the Scan Area. Then click Scan. Your document is
scanned, processed into editable text, and opened in the FineReader window.
In Office Mode, select Color, Grayscale, or Black&White as the Image Type and
Document Table as the Document Source. Select the size of your original
document as the size setting, and 300 dpi as the Resolution. Preview and select
your scan area (click the Help button in the Epson Scan window for instructions).
Then click Scan. Your document is scanned, processed into editable text, and
opened in the FineReader window.
In Professional Mode, select Reflective as the Document Type, Document Table as
the Document Source, and Document as the Auto Exposure Type. Then select
Black & White or 24-bit Color as the Image Type, and 300 dpi as the Resolution.

Preview and select your scan area as described in Previewing and Adjusting the Scan
Area. Then click Scan. Your document is scanned, processed into editable text, and
opened in the FineReader window.
Note:

In Home, Office, or Professional Mode, if the characters in your text are not
recognized very well, you can improve recognition by adjusting the Threshold
setting. If you are using Home or Professional Mode, see Adjusting the Color and
Other Image Settings for instructions. If you are using Office Mode, click the Help
button in the Epson Scan window for instructions.

Follow the instructions in ABBYY FineReader Help to edit and save your document.
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Scanning and Printing Color Accurate Images
Scanning and Saving Your Image
Printing Your Image
You can optimize the color accuracy of your images using a photo-editing application, such as
Adobe Photoshop Elements.
Note:

Not all versions of Photoshop Elements are fully compatible with Windows Vista. If
you are using Windows Vista, you may need to upgrade to the latest version of
Photoshop Elements.

Scanning and Saving Your Image
Do one of the following.
Windows: Open Adobe Photoshop Elements and select Edit and Enhance Photos.
Mac OS X: Open Adobe Photoshop Elements. If you see the Welcome window, click Close.
Click Edit (Windows) or Photoshop Elements (Mac OS X) and select Color Settings.
Select Full Color Management and click OK.

Select File > Import > EPSON Perfection V500.
When the Epson Scan window appears, set the scan mode to Home Mode or
Professional Mode. See one of these sections for instructions.
Documents or photos: Changing the Scan Mode
Film or slides: Changing the Scan Mode
Note:

You cannot use Full Auto Mode for color management.

Click the Preview button to preview your image(s), then select your scan area. See one of
these sections for instructions.
Documents: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Click the Configuration button, then click the Color tab and select ICM (Windows) or
ColorSync (Mac OS X).
For the Source (Scanner) setting, select EPSON Standard. If you have color management
software and created a custom ICC profile, select it as the Source (Scanner) setting.
Note:

When creating a custom ICC profile for the scanner, be sure to place the profile in
the following folder.
Windows Vista and XP: C:\Windows\System32\Spool\Drivers\Color
Windows 2000: C:\WINNT\System32\Spool\Drivers\Color
Mac OS X: hard disk drive\Library\ColorSync\Profiles

For the Target setting, select Adobe RGB.
Select Display preview using monitor compensation, then click OK to return to the
Epson Scan window.
Click Scan to scan your image.
If Epson Scan does not automatically close after scanning, click the Close button to close
the Epson Scan window.
Your image appears in Adobe Photoshop Elements.
Save your image by selecting File > Save As.
In the Save As window, select ICC Profile (Windows) or Embed Color Profile (Mac OS X)
as the Color setting to save the profile with your image.
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Printing Your Image
From the File menu, select Print.
Click the Show More Options box and select Same As Source as the Print Space setting.

Check the settings in your printer software and make any changes necessary for your print
job, then click Print to print your image. For details on selecting printer settings, see your
printer’s documentation.
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Assigning Another Windows Program to a Scanner Button
Assigning a Program With Windows Vista
Assigning a Program With Windows XP
Assigning a Program With Windows 2000
You can assign the scanner buttons to any Windows program that supports scanner events, such
as Photoshop Elements. If you have a compatible program, it will appear in the selection window.
The steps you use depend on the version of Windows you have. See the section for your
Windows version below.

Assigning a Program With Windows Vista
Click

> Control Panel > Hardware and Sound > Scanners and Cameras, or click
> Control Panel and then double-click the Scanners and Cameras icon.

Click your scanner’s icon, then click Properties. When you see the User Account Control
window, click Continue.
Click the Events tab.

In the Select an event list, choose the button to which you want to assign a program.
In the Start this program list, choose the program you want to assign. Only compatible
programs appear in the list.
Note:

If you want to be given a choice of programs whenever you press the selected
button, click the Prompt for which program to run button instead. If you want
to disable the button from opening a program, click the Take no action button
instead.

Click OK.
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Assigning a Program With Windows XP
Click Start > Control Panel > Printers and Other Hardware > Scanners and
Cameras, or click Start > Control Panel and then double-click the Scanners and
Cameras icon.
Right-click your scanner’s icon and select
Properties.
Click the Events tab.

In the Select an event list, choose the button to which you want to assign a program.
In the Start this program list, choose the program you want to assign. Only compatible
programs appear in the list.
Note:

If you want to be given a choice of programs whenever you press the selected
button, click the Prompt for which program to run button instead. If you want
to disable the button from opening a program, click the Take no action button
instead.

Click Apply, then click OK.
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Assigning a Program With Windows 2000
Click Start > Settings > Control Panel.
Double-click the Scanners and Cameras icon.
Select your scanner and click Properties.
Click the Events tab.
In the Scanner events list, choose the button to which you want to assign a program.
In the Send to this application list, click the checkbox for the program you want to
assign. Only compatible programs appear in the list.
Note:

If you want to be given a choice of programs whenever you press the selected
button, select more than one program in the list. If you want to disable the button
from opening a program, click the Disable device events checkbox instead.

Click Apply, then click OK.

Note:

You must restart your computer before using the newly assigned scanner buttons.
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Unpacking the Automatic Document Feeder
The Automatic Document Feeder (B12B813391) allows you to automatically load multiplepage documents into your scanner. This is particularly useful for scanning documents for
OCR (Optical Character Recognition) and for quickly creating an image database.
Make sure you have all the items illustrated below. If any items are missing or damaged,
contact Epson. See Epson Technical Support for details.
When you are ready to install the Automatic Document Feeder (ADF), see Installing the
Automatic Document Feeder.
Automatic Document Feeder

Paper support
Holds up the paper that is loaded in the ADF.

Spare paper path guide
The paper path guide directs documents smoothly onto the scanner's document table. A
spare paper path guide is included. If the surface of the paper path guide gets dirty, you
can clean it or replace it with the spare guide. See Cleaning and Replacing the Paper Path
Guide.

ADF Document Mat
You can place this mat over a document if you need to scan it from the document table
when the ADF is installed. See Placing Documents on the Document Table With the
Automatic Document Feeder Installed.
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Installing the Automatic Document Feeder
Whenever you want to use the ADF, you need to remove the scanner cover and replace it with
the ADF.
Exit Epson Scan and turn off your scanner using its power switch.
Disconnect the cover cable.

Open the scanner cover.

Pull the scanner cover straight up and off the scanner.

Remove the tape and other packing materials from the ADF.
Insert the hinge posts on the ADF into the holes in the top of the scanner, at the back
edge. Then close the ADF.

Connect the ADF cable to the scanner’s OPTION port.

Slide the paper support into its slot on the edge of the sheet feeder on the ADF.

To load documents into the ADF, see Loading Documents in the Automatic Document Feeder.
Note:

If you need to scan documents or photos from the document table glass while the
ADF is installed, follow the instructions in Placing Documents on the Document
Table With the Automatic Document Feeder Installed.
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Loading Documents in the Automatic Document Feeder
Document Specifications
Placing Documents on the Document Table With the Automatic Document Feeder Installed
You can load up to 30 sheets of paper in the ADF (based on a stack thickness of 0.2 inch [6
mm] or less).
For the best results, all of the sheets you load at one time should be the same size. If you
load sheets of differing sizes, carefully follow the loading and scanning instructions for mixedsize documents.
The table below lists the sizes of paper you can load in the ADF. Also check Document
Specifications for detailed specifications.
Paper name

Size

Letter

8.5 × 11 inches (215.9 × 279.4 mm)

Legal

8.5 × 14 inches (215.9 × 355.6 mm)

A4

8.27 × 11.69 inches (210 × 297 mm)

B5

7.17 × 10.1 inches (182 × 257 mm)

Note:

Remove any documents from the document table and make sure there is
no dust on the glass before loading documents in the ADF.
If you need to scan documents or photos from the document table glass
while the ADF is installed, follow the instructions in Placing Documents on
the Document Table With the Automatic Document Feeder Installed.

Follow these steps to load documents in the ADF:
Extend the metal support at the end of the output tray on the ADF.

Slide the edge guide on the input tray of the ADF all the way to the right.

Place your stack of paper in the input tray with the printed side facing up and the top
edge facing into the feeder. Slide the paper into the feeder until it meets resistance.
Then slide the edge guide over to the edge of the paper.

Note:

If you loaded mixed-size sheets, make sure the top edge of all the sheets are
aligned so they feed into the ADF correctly.

To scan your documents using the ADF, see Scanning Using the Automatic Document Feeder.

Document Specifications

Load only documents that meet the following specifications in the ADF:
Size

Width 3.94 to 8.5 inches (100 to 215.9 mm)
Length 5 to 14 inches (127 to 355.6 mm)

Thickness

0.07 to 0.16 mm

Weight

60 to 105 g/m2

Paper type

High-quality bond paper

Printing type

Documents printed with impact printers, laser printers, or
facsimile machines

Make sure your documents meet the following conditions before loading them into the ADF:
The ink is dry.
The document has no holes and is not ripped or wrinkled.
The document has no staples, paper clips, or other objects attached to it; these may
damage the feeder mechanism.
The document has no folds within 0.2 inch (5 mm) from the edges.
The document has no cut-out areas.
The document is not a multipart form or bound.
The document has no rear carbon coating.
Caution:

Do not feed photographs or valuable original artwork into the ADF. Misfeeding
may wrinkle or damage the original. Scan high-quality color or halftone
documents on the document table instead.
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Placing Documents on the Document Table With the Automatic Document
Feeder Installed
You can scan documents or photos on the document table glass while the ADF is installed.
Follow these steps:
Open the ADF.

Place your document or photo on the document table, face-down on the glass. Make
sure the top of the document or photo is against the rear right corner of the document
table.
Place the ADF document mat on top of the document or photos on the document table.

Close the ADF.

Note:

If you are scanning a large or thick document, you can scan with the ADF
open. To scan documents or photos that are normal size and thickness,
always close the ADF.
Home Mode, Office Mode, and Professional Mode are available for
scanning your documents on the document table while the ADF is
installed.
If you are using Home Mode or Professional Mode to scan your
documents while the ADF is installed, see Selecting Basic Settings.
If you are using Office Mode to scan your documents on the document
table while the ADF is installed, make sure Office Mode is selected and
then click the Help button in the Epson Scan window for instructions.
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Scanning Using the Automatic Document Feeder
When you scan documents with the ADF, it is best to use Office Mode.
Note:

Do not open the ADF while you are scanning or you will see an option error
and paper feeding will stop.
Do not load mixed-size document pages when you are scanning only a
portion of each page.
Office Mode and Professional Mode are available for scanning documents
using the ADF.

Make sure you installed the ADF and loaded your document in it. See Loading Documents
in the Automatic Document Feeder for instructions.
Start Epson Scan. See one of these sections for instructions.
Starting a Scan With the Scanner Buttons
Starting a Scan With Epson Scan
Starting a Scan With Another Scanning Program
Click the arrow in the Mode box at the top right of the Epson Scan window. Then select
Office Mode.

You see the Office Mode window:

Select whether the Image Type of your document pages is Color, Grayscale, or
Black&White.
Select Auto Detect, ADF, or Document Table as the Document Source setting.

Note:

If you loaded mixed-size sheets at one time, select Auto Detect.

Select the size of your original document as the Size setting.
Click the arrow next to the Resolution list and select the number of dots per inch at which
you want to scan. See the table below for some guidelines:

What you will do with the
scanned image

Suggested scan resolution

Send via e-mail, upload to web, view
only on the screen

96 to 150 dpi

Print, convert to editable text (OCR)

300 dpi

Fax

200 dpi

Click the Preview button toward the bottom of the Epson Scan window.
The ADF loads your first document page, then Epson Scan prescans it and displays it in the
Preview window. The ADF then ejects your first page.
Place your first page on top of the rest of the pages, then load the entire document into
the ADF.
In the Preview window, draw a marquee (a line marking the scan area) around the portion
of your document page that you want to scan.
For instructions on creating and adjusting a marquee, see Adjusting the Scan Area
(Marquee).
Change any necessary Image Adjustments settings as listed in the table below.

Setting

Available mode(s) and description

Brightness

Adjusts the overall image lightness and darkness.

Contrast

Adjusts the difference between the light and dark areas
of the overall image.

Unsharp Mask

Turn on to make the edges of image areas clearer for
an overall sharper image. Turn off to leave softer edges.

Descreening

Removes the rippled pattern that can appear in subtlyshaded image areas, such as in skin tones. Also
improves results when scanning magazine or
newspaper images which include screening in their
original print processes.

Text Enhancement

Enhances text recognition when scanning text
documents.

Threshold

Adjusts the level at which the black areas in text and
line art are delineated, improving text recognition in
OCR programs. This setting is available only when the
Image Type is set to Black&White.

Auto Area
Segmentation

Makes grayscale images clearer and text recognition
more accurate by scanning text in black & white while
retaining the grayscale of the image. (Available only
when you select Black&White as the Image Type
setting.)

Image Option > Color
Enhance

Enhances the color you select (red, green, or blue) in
the scan. (Available only when you select Grayscale or
Black&White as the Image Type setting.)

Image Option >
Dropout

Drops out the color you select (red, green, or blue)
from the scan. (Available only when you select
Grayscale or Black&White as the Image Type
setting.)

Click the Scan button to scan your document pages.
What happens next depends on how you started your scan.
Start button or running Epson Scan as a
If you started your scan by pressing the
standalone program, you see the File Save Settings window. See Selecting File Save
Settings for details.
If you started your scan from a scanning program such as ABBYY FineReader, your
scanned pages open in the program window. Click Close to close the Epson Scan
window and view your scanned pages in the program.
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Cleaning and Replacing the Paper Path Guide
After you have used the ADF for a long time, a line of dots may begin to appear on the
scanned images. If this happens, follow the steps below to clean the paper path guide. If the
problem persists, you may need to replace the paper path guide with the spare one that
came with your ADF.
Turn off the scanner using its power switch.
Push in the support on the edge of the output tray on the ADF.

Remove the paper support from the input tray of the ADF.

If the ADF is installed on your scanner, disconnect its cable from the scanner’s OPTION
port, open the ADF, and lift it off of the scanner.
Turn the ADF over onto its top and carefully place it on a stable surface.

Lift up the edges of the clips holding the paper path guide in place and push the clips all
the way out of the notches to release them.
Remove the paper path guide in the direction shown below.

Using a soft, dry cloth, wipe the clear portion of the paper path guide to clean off any
dust or dirt.

Slide the paper path guide back into place beneath the white document mat on the
ADF. Then insert the clips beneath the notches and push them all the way back until
they click into place.

Install the ADF on the scanner (see Installing the Automatic Document Feeder). Then
try scanning with the ADF again, as described in Scanning Using the Automatic
Document Feeder.
If you still see a line of dots in your images, follow these steps again to remove the
paper path guide and replace it with the spare one that came with your ADF.
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Cleaning the Scanner
To keep your scanner operating at its best, clean it periodically using the following procedure.
Turn off the scanner using its power switch.
Unplug the AC adapter cord from the scanner.
Clean the outer case with a cloth dampened with mild detergent and water.
If the glass surface of the document table gets dirty, clean it with a soft, dry microfiber
cloth. If the glass surface is stained with grease or some other hard-to-remove material,
use a small amount of glass cleaner and a soft cloth to remove it. Spray the cleaner
onto the soft cloth; never spray cleaner directly onto the glass. Wipe off all remaining
liquid.
Remove the document mat and clean the transparency unit window as described in step
4.

a. transparency unit window
Make sure that no dust builds up on the surface of the document table or the transparency
unit window. Dust can cause spots in your scanned images.
Caution:

Do not press the glass surface of the document table with any force.
Be careful not to scratch or damage the glass surface of the document
table, and do not use a hard or abrasive brush to clean it. A damaged
glass surface can decrease the scan quality.
Never use alcohol, paint thinner, or corrosive solvent to clean the
scanner. These chemicals can damage the scanner components and the
case.
Be careful not to spill liquid into the scanner mechanism or electronic
components. This could permanently damage the mechanism and
circuitry.
Do not spray lubricants inside the scanner.
Never open the scanner case.
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Replacing the Scanner Light Source
The luminosity of the scanner light source declines over time. If the light source
breaks or becomes too dim to operate normally, the scanner stops working and
the status light rapidly flashes orange. When this happens, the light source
assembly must be replaced. For details, contact Epson. See Epson Technical
Support for details.
Caution:

Never open the scanner case. If you think repairs or adjustments are
necessary, contact Epson.
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Transporting the Scanner
Before transporting the scanner for a long distance or storing it for an extended period of time,
you need to lock the scanner’s carriage and transparency unit to prevent damage.
Plug in the scanner, connect it to your computer, turn on the scanner using its power
switch, and wait until the carriage moves to the home position (near the cover hinge).
While the status light is green, turn off the scanner using its power switch.
Note:

If the optional ADF is installed, make sure the scanner is turned off, then
disconnect the ADF’s cable and remove the ADF from the scanner. Place the
scanner cover on the scanner, but do not connect the cover cable.

Open the scanner cover and slide the transparency unit transportation lock to the locked
position. Then close the scanner cover.

If the cover cable is attached, disconnect it.

Disconnect the USB cable.
On the back of the scanner, slide the transportation lock to the locked position to secure
the scanner carriage.

Attach the protective materials, then repack the scanner in its original box or a similar box
that fits the scanner snugly.
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Reading the Status Light
If an error occurs, the scanner stops operating and the status light flashes orange.
This indicates one of the following problems:
The scanner is not connected to your computer properly or your software is
not fully installed. See the Start Here sheet that came with your scanner for
instructions on installing the software and connecting the scanner to your
computer.
The scanner and/or the transparency unit transportation lock is locked. Slide
the lock to the unlock position.
The scanner cover cable or optional Automatic Document Feeder cable is not
connected to the scanner’s OPTION port. Connect the cable to the port.
Note:

Before connecting or disconnecting the scanner cover cable or the
Automatic Document Feeder cable, turn off the scanner using its
power switch.

After trying these solutions, turn off the scanner using its power switch, then turn it
back on.
If the status light is still flashing:
The scanner may be malfunctioning.
The scanner light source may need to be replaced.
The connected optional equipment may be malfunctioning.
Contact Epson. See Epson Technical Support for details.
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Scanner Problems
The Scanner Does Not Scan
The Scanner Is Not Recognized by Your System
Pressing a Scanner Button Does Not Start the Correct Program
You Cannot Scan Multiple Images at One Time
See your Start Here sheet for instructions on setting up your scanner. If you have problems
operating the scanner, make sure:
Your scanner’s AC adapter is securely connected to the scanner and a working electrical
outlet.
The power outlet works. (If necessary, test it by plugging in another electrical device
and turning it on.)
If you still have problems scanning, see the other topics in this section.

The Scanner Does Not Scan
Wait until the status light turns green to indicate that the scanner is ready to scan.
Your system may not work properly if you use a USB cable other than the one that
came with your scanner.
The scanner may not work properly when connected to the computer through more than
one USB hub. Connect the scanner directly to the computer’s USB port or through one
hub only.
The scanner may not work properly when your computer is in standby mode (Windows)
or sleep mode (Mac OS X). Restart Epson Scan and try scanning again.
The scanner may not work properly if you upgrade your operating system but do not
reinstall Epson Scan. See Uninstalling Your Scanning Software for instructions on
uninstalling Epson Scan. Reinstall Epson Scan by following the instructions in your Start
Here sheet.
In Mac OS X Classic mode, the scanner will not work properly. Use the Mac OS X
interface instead.
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The Scanner Is Not Recognized by Your System

First check your connection to the scanner and computer:
Make sure your scanner’s AC adapter is securely connected to the scanner and a
working electrical outlet.
Make sure the interface cable is securely connected to the scanner and your computer,
and that the cable is not damaged or crimped.
Your system may not work properly if you use a USB cable other than the one that
came with your scanner.
The scanner may not work properly when connected to the computer through more than
one USB hub. Connect the scanner directly to the computer’s USB port or through one
hub only.
Check to see if your computer system meets the requirements for the scanner interface
you are using. See System Requirements for details.
If Windows still has problems recognizing your scanner, make sure your computer
supports USB. See Checking For Windows USB Support for instructions.

Checking For Windows USB Support
Do one of the following.

Windows Vista: Click
System, or click

> Control Panel > System and Maintenance >

> Control Panel and then double-click the System icon.

Windows XP: Click Start > Control Panel > Performance and Maintenance >
System, or click Start > Control Panel and then double-click the System icon.
Windows 2000: Click Start > Settings > Control Panel. Then double-click the
System icon.
Do one of the following.
Windows Vista: Click Device Manager, then click Continue in the User Account
Control window.
Windows XP and 2000: Click the Hardware tab, then click the Device Manager
button.
Scroll down if necessary, then double-click Universal Serial Bus controllers.

If a USB Universal Host Controller and USB Root Hub are listed, Windows supports
USB.
Try scanning again. If your scanner still is not recognized, contact Epson for assistance.
See Epson Technical Support for details.
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Pressing a Scanner Button Does Not Start the Correct Program
Make sure Epson Scan and Epson Event Manager are installed correctly. See the Start
Here sheet for instructions.
Make sure your Windows system is set up for scanner events as follows.
Windows Vista:
Click

> Control Panel > Hardware and Sound > Scanners and Cameras, or

click
> Control Panel and double-click the Scanners and Cameras icon. Click
your scanner’s icon, then click Properties (when you see the User Account Control
window, click Continue). Click the Events tab in your scanner’s Properties window and
make sure Take no action is not selected. Also, make sure the desired button is
selected in the Select an event list box, and Start this program is selected. If you are
using Epson Event Manager with the button, you must select Epson Event Manager in
the Start this program list.
Windows XP:
Click Start > Control Panel > Printers and Other Hardware > Scanners and
Cameras, or click Start > Control Panel and double-click the Scanners and
Cameras icon. Then right-click your scanner’s icon and select Properties. Click the
Events tab in your scanner’s Properties window and make sure Take no action is not
selected. Also, make sure the desired button is selected in the Select an event list box,
and Start this program is selected. If you are using Epson Event Manager with the
button, you must select Epson Event Manager in the Start this program list.
Windows 2000:
Click Start > Settings > Control Panel, double-click the Scanners and Cameras
icon, then select your scanner and click Properties. Click the Events tab in your
scanner’s Properties window and make sure the Disable device events checkbox is not
checked. Also, make sure the desired button is selected in the Scanner events list box,
and the desired application in the Send to this application list is selected. If you are
using Epson Event Manager with the button, you must select Epson Event Manager in
the Send to this application list.
In Mac OS X, make sure you did not install the scanner software in Classic mode or run
it in Classic mode.
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You Cannot Scan Multiple Images at One Time
Position photos at least 0.8 inch (20 mm) apart from each other on the document table.
Make sure your scanning program can scan multiple images.
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Scanning Software Problems
You Cannot Start Epson Scan
The Scanner Software Does Not Work Properly
You Cannot Scan in Full Auto Mode
You Cannot Scan Using the Thumbnail Preview
Scanning Takes a Long Time
Images Are Rotated Incorrectly
Note:

Periodically, it’s a good idea to check Epson’s support website for
free updates to your Epson Perfection V500 Office software (U.S.
downloads or Canadian downloads). With Windows, you can also
or Start > All Programs or Programs > EPSON >
select
EPSON Scan > Perfection V500 Office Scanner Driver
Update.
Some Epson Scan settings may be unavailable or grayed out based
on the currently selected settings or the currently installed optional
accessories.

You Cannot Start Epson Scan
Make sure the scanner is turned on.
Turn off your computer and scanner, then check the USB cable connection
between them to make sure it is secure.
The scanner may not work properly when your computer is in standby mode
(Windows) or sleep mode (Mac OS X). Restart Epson Scan and try scanning
again.
The scanner may not work properly if you upgrade your operating system but
do not reinstall Epson Scan. See Uninstalling Your Scanning Software for
instructions on uninstalling Epson Scan. Reinstall Epson Scan by following the
instructions in your Start Here sheet.
Make sure that Epson Scan is selected in your scanning program. See Starting

a Scan With Another Scanning Program for documents and photos or Starting
a Scan With Another Scanning Program for film and slides.
In the Windows Device Manager, make sure your scanner’s name appears
under Imaging devices without a question (?) or an exclamation (!) mark,
or a red X. If the scanner appears with one of these marks or as an
Unknown device, uninstall Epson Scan as described in Uninstalling Epson
Scan. Then reinstall it by following the instructions in your Start Here sheet.
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The Scanner Software Does Not Work Properly
Make sure your computer has enough memory and meets the other system
requirements for the software you are using. See your software and computer
documentation for details.
With Windows, check whether your scanner appears more than once in the
Scanners and Cameras utility. Do one of the following:
Windows Vista:
Click

> Control Panel > Hardware and Sound > Scanners and

> Control Panel and double-click the Scanners and
Cameras, or click
Cameras icon. Then delete your scanner’s icon and uninstall and reinstall
Epson Scan. See Uninstalling Your Scanning Software for instructions on
uninstalling Epson Scan. Reinstall Epson Scan by following the instructions in
your Start Here sheet.
Windows XP:
Click Start > Control Panel > Printers and Other Hardware > Scanners
and Cameras, or click Start > Control Panel and double-click the
Scanners and Cameras icon. Then delete your scanner’s icon and uninstall
and reinstall Epson Scan. See Uninstalling Your Scanning Software for
instructions on uninstalling Epson Scan. Reinstall Epson Scan by following the
instructions in your Start Here sheet.
Windows 2000:
Click Start > Settings > Control Panel, double-click the Scanners and
Cameras icon, and delete your scanner from the list of installed devices.
Then uninstall and reinstall Epson Scan. See Uninstalling Your Scanning
Software for instructions on uninstalling Epson Scan. Reinstall Epson Scan by
following the instructions in your Start Here sheet.
The scanner may not work properly if Epson Scan is open and your computer
goes into standby mode (Windows) or sleep mode (Mac OS X). Restart Epson
Scan and try scanning again.
The scanner may not work properly if you upgrade your operating system but
do not reinstall Epson Scan. See Uninstalling Your Scanning Software for
instructions on uninstalling Epson Scan. Reinstall Epson Scan by following the
instructions in your Start Here sheet.
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You Cannot Scan in Full Auto Mode
Epson Scan may not be able to detect certain types of images, or may crop or group
the images unexpectedly. This may happen if you scan the following items:
Images with a dark background
Images with a very bright background
Color negative film with extremely light or dark base color (background)
Note:

In Full Auto Mode, you can scan only 35mm color negative film strips
or color positive slides. To scan other types of film, use Home or
Professional Mode.

Panorama and regular size images being scanned at the same time
Try one or more of the following solutions.
For documents or photos:
Make sure the documents or photos are placed on the scanner’s document
table correctly. See Placing Documents or Photos for instructions.
Try scanning in Home or Professional Mode instead. To change the scan
mode, see Changing the Scan Mode.
For film or slides:
Make sure the film or slides are placed in the film holder correctly and the film
holder is properly positioned on the document table. See Placing Film or
Slides for instructions.
Make sure the white stickers on the back of the film holder and the areas
around them are not scratched, dusty, or covered in any way. If the areas are
obscured, the scanner may have trouble recognizing your film or slides. If the
problem persists, try scanning in Home or Professional Mode. To change the
scan mode, see Changing the Scan Mode.
Make sure the document mat is removed when you scan film or slides. See
Removing the Document Mat.
Try scanning in Home or Professional Mode instead. To change the scan
mode, see Changing the Scan Mode.
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You Cannot Scan Using the Thumbnail Preview
Epson Scan may not be able to detect certain types of images, or may crop or group
the images unexpectedly. This may happen if you scan the following items:
Images with a dark background
Images with a very bright background
Color negative film with extremely light or dark base color (background)
Panorama and regular size images being scanned at the same time
Try one or more of the following solutions.
For documents or photos:
Make sure the documents or photos are placed on the scanner’s document
table correctly. See Placing Documents or Photos for instructions.
Use normal preview (if available) and create marquees on the areas you want
to scan. See Previewing and Adjusting the Scan Area for instructions.
For film or slides:
Make sure the film or slides are placed in the film holder correctly and the film
holder is properly positioned on the document table. See Placing Film or
Slides for instructions.
In the Configuration window, adjust the thumbnail cropping area using the
Thumbnail Cropping Area slider. See Epson Scan Help for details.
Make sure the document mat is removed when you scan film or slides. See
Removing the Document Mat for instructions.
Make sure the Document Type setting (Home Mode) or Document Type and
Film Type settings (Professional Mode) are set correctly for your film/slide
type. See Selecting Basic Settings for instructions.
Use normal preview (if available) and create marquees on the areas you want
to scan. See Previewing and Adjusting the Scan Area for instructions.
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Scanning Takes a Long Time
If you are scanning film or slides, or using the scanner’s Digital ICE
Technology feature, scanning takes longer than usual.
Computers with USB 2.0 (high speed) ports can transfer data faster than
those with USB 1.1 ports. Therefore, the scanning time may be shorter if you
use a computer with a USB 2.0 port. If you are using a USB 2.0 port with your
scanner, make sure it meets the system requirements. See System
Requirements for details.
Try scanning your original at a lower Resolution setting to speed up scanning.
See Selecting the Scan Resolution for documents and photos, or Selecting the
Scan Resolution for film and slides.

Top

Images Are Rotated Incorrectly
Try one or more of the following solutions.
For documents or photos:
Make sure the documents or photos are placed on the scanner’s document
table correctly. See Placing Documents or Photos for instructions.
Try disabling or enabling the Auto Photo Orientation setting. To access this
setting, click Customize if you’re scanning in Full Auto Mode or
Configuration if you’re scanning in Home or Professional Mode.
Note:

The Auto Photo Orientation feature will not work when you scan
newspaper or magazine pages, documents, illustrations, or line
art. The feature will also not work when you scan images that
are 2 inches (5.1 cm) or smaller on any side.
The Auto Photo Orientation feature may not work correctly for
all image types. For example, it works best on outdoor images
that include a bright sky at the top. For images of people, it
works best when they are facing forward and are not too far
away.

If you’re scanning using Thumbnail previews (Home or Professional Mode
only), select the image and click the
rotation icon to rotate it. See
Previewing and Adjusting the Scan Area for instructions.
For film or slides:
Make sure the film or slides are placed in the film holder correctly and the film
holder is properly positioned on the document table. See Placing Film or
Slides for instructions.
Try disabling or enabling the Auto Photo Orientation setting. To access this
setting, click Customize if you’re scanning in Full Auto Mode or
Configuration if you’re scanning in Home or Professional Mode.
Note:

The Auto Photo Orientation feature will not work when you scan
newspaper or magazine pages, documents, illustrations, or line
art. The feature will also not work when you scan images that
are 2 inches (5.1 cm) or smaller on any side.
The Auto Photo Orientation feature may not work correctly for
all image types. For example, it works best on outdoor images
that include a bright sky at the top. For images of people, it
works best when they are facing forward and are not too far
away.

If you’re scanning using Thumbnail previews (Home or Professional Mode
only), select the image and click the
rotation icon to rotate it. See
Previewing and Adjusting the Scan Area for instructions.
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Scan Quality Problems
The Edges of Your Document Are Not Scanned
You See Only a Few Dots in Your Scanned Image
A Line of Dots Always Appears in Your Scanned Images
Straight Lines in Your Image Come Out Crooked
Your Image Is Distorted or Blurred
Colors Are Patchy or Distorted at the Edges of Your Image
Your Scanned Image Is Too Dark
An Image on the Back of Your Original Appears in Your Scanned Image
Ripple Patterns Appear in Your Scanned Image
Characters Are Not Recognized Well When Converted into Editable Text (OCR)
Scanned Colors Differ From the Original Colors
You Have Trouble Adjusting the Scan Area in the Thumbnail Preview

The Edges of Your Document Are Not Scanned
Move the document about 0.12 inch (3 mm) away from the horizontal and vertical edges of the
document table to avoid cropping.
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You See Only a Few Dots in Your Scanned Image
Make sure the document or photo is placed on the scanner’s document table with the
side to be scanned facing down. See Placing Documents or Photos for details.
When scanning with the Black & White setting in Home or Professional Mode, change
the Threshold setting. See Adjusting the Color and Other Image Settings for
instructions.
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A Line of Dots Always Appears in Your Scanned Images
The document table or transparency unit window may be dusty or scratched. Clean the
document table and transparency unit window as described in Cleaning the Scanner. If
you still have the problem, contact Epson. See Epson Technical Support for details.
If you are using the optional ADF, you may need to clean or replace the paper path
guide. See Cleaning and Replacing the Paper Path Guide for instructions.
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Straight Lines in Your Image Come Out Crooked
Make sure the document lies perfectly straight on the document table. Align the text or any
vertical or horizontal lines with the marks at the rear left and front right corners of the
document table.
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Your Image Is Distorted or Blurred

Make sure the document or photo lies flat on the document table. Also make sure your
document or photo is not wrinkled or warped.
Caution:

Do not place heavy objects on the document table glass and do not press the
glass with too much force.

Make sure you do not move the document or photo, or your scanner while scanning.
Make sure the scanner is placed on a flat, stable surface.
Make sure Unsharp Mask is selected in Epson Scan’s Professional Mode window. See

Adjusting the Color and Other Image Settings for documents and photos or Adjusting
the Color and Other Image Settings for film and slides.
Adjust the Auto Exposure setting in Epson Scan’s Professional Mode window. See
Adjusting the Color and Other Image Settings for documents and photos or Adjusting
the Color and Other Image Settings for film and slides.
You can also click Configuration in the Epson Scan window, click the Color tab, then
click the Recommended Value button to return the Auto Exposure setting to the
default value. See Epson Scan Help for details.
Increase the Resolution setting. See Selecting the Scan Resolution for documents and
photos or Selecting the Scan Resolution for film and slides.
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Colors Are Patchy or Distorted at the Edges of Your Image

If your document is very thick or curled at the edges, cover the edges with paper to block
external light as you scan.
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Your Scanned Image Is Too Dark

Change the Display Gamma setting to match your output device, such as a monitor
or printer, in the Epson Scan Configuration window. See Epson Scan Help for details.

If your original is too dark, try using the Backlight Correction feature. See Fixing
Backlit Photos for instructions.
Adjust the Auto Exposure setting in Epson Scan’s Professional Mode window. See
Adjusting the Color and Other Image Settings for documents and photos or Adjusting
the Color and Other Image Settings for film and slides.
You can also click Configuration in the Epson Scan window, click the Color tab, then
click the Recommended Value button to return the Auto Exposure setting to the
default value. See Epson Scan Help for details.
Adjust the Brightness setting in Epson Scan’s Home or Professional Mode (see Epson
Scan Help). Or adjust the brightness using the Histogram in Professional Mode (see
Epson Scan Help).
Check the brightness and contrast settings of your computer monitor.
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An Image on the Back of Your Original Appears in Your Scanned Image
If your original is printed on thin paper, images on the back may be visible to the scanner and
appear in your scanned image. Try scanning the original with a piece of black paper placed on
the back of it. Also make sure the Document Type and Image Type settings are correct for your
original. See Selecting Basic Settings for details.
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Ripple Patterns Appear in Your Scanned Image
A ripple or cross-hatch pattern (called moiré) may appear in a scanned image of a printed
document. It is caused by interference from the differing pitches in the scanner’s screen and
the halftone screen in your original.
Original image

Descreening applied

Select the Descreening checkbox in Epson Scan’s Home or Professional Mode window.
In Professional Mode, select an appropriate Screen Ruling for the Descreening and
deselect the Unsharp Mask setting. See Adjusting the Color and Other Image Settings
for instructions.
Select a lower Resolution setting. See Selecting the Scan Resolution for instructions.
Note:

You cannot remove ripple patterns when you are scanning film or
monochrome images.
You cannot remove ripple patterns when you are scanning in Home Mode
using a resolution higher than 600 dpi. In Professional Mode, you may be
able to remove ripple patterns at resolutions higher than 600 dpi if you
reduce the Scale setting.
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Characters Are Not Recognized Well When Converted into Editable Text (OCR)
Make sure the document lies perfectly straight on the document table. Align the text or
any vertical or horizontal lines with the marks at the rear left and front right corners of
the document table.
In Home Mode, select Black&White as the Image Type setting. In Professional Mode,
select Black & White as the Image Type setting, then click the + next to Image
Type and select None for the B&W Option setting. Then try adjusting the Threshold
setting. See Converting Scanned Documents Into Editable Text for instructions.
Check your OCR software manual to see if there are any settings you can adjust in
your OCR software.
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Scanned Colors Differ From the Original Colors
Change the Image Type setting in Epson Scan’s Home or Professional Mode. See
Selecting Basic Settings for documents and photos or Selecting Basic Settings for film
and slides. Select different combinations of this setting and the others mentioned
below.
Change the Display Gamma setting to match your output device, such as a monitor or
printer, in the Epson Scan Configuration window. See Epson Scan Help for details.
Adjust the Auto Exposure setting in Epson Scan’s Professional Mode. Also try
selecting a different Tone Correction setting. See Adjusting the Color and Other Image
Settings for documents and photos or Adjusting the Color and Other Image Settings
for film and slides.

Try selecting the following settings in the Configuration window: Color Control,
Continuous auto exposure, and Recommended Value (on the Color tab). Also try
turning off the Fast Preview setting. See Epson Scan Help for details.
Make sure to enable the Embed ICC Profile setting. To access this setting, click the
Customize button and then the File Save Settings button if you are scanning in Full
File Save Settings button to the right of the Scan button if you
Auto Mode, or the
are scanning in Home or Professional Mode. The File Save Settings window appears.
Select JPEG or TIFF as the Type setting, then click Options. (If you started Epson
Scan from a program like Adobe Photoshop Elements, this button does not appear.)
Check the color matching and color management capabilities of your computer, display
adapter, and software. Some computers can change the palette of colors on your
screen. See your software and hardware manuals for details.
Use the color management system for your computer: ICM for Windows or ColorSync
for Mac OS X. With Windows, add a color profile that matches your monitor to improve
on-screen color matching. Also, see Scanning and Printing Color Accurate Images.
(Exact color matching is very difficult. Check your software and monitor documentation
for information on color matching and calibration.)
Printed colors can never exactly match the colors on your monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and
printers typically use CMYK (cyan, magenta, yellow, and black).
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You Have Trouble Adjusting the Scan Area in the Thumbnail Preview
Create a marquee or adjust the existing marquee to select the area you want to scan.
See one of these sections for instructions.
Documents or photos: Adjusting the Scan Area (Marquee)
Film or slides: Adjusting the Scan Area (Marquee)
In the Configuration window, adjust the thumbnail cropping area using the Thumbnail
Cropping Area slider. See Epson Scan Help for details.
Switch to the normal preview type (if available) and preview your image again. See
one of these sections for instructions.
Documents or photos: Previewing and Adjusting the Scan Area
Film or slides: Previewing and Adjusting the Scan Area
Top
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Film or Slide Scanning Problems
You Cannot Scan Film or Slides
Negative Film Preview Images Look Strange
Striped Rings Appear in Your Scanned Image
A Line Appears in the Previewed Image

You Cannot Scan Film or Slides
Make sure the document mat is removed from the scanner cover. See
Removing the Document Mat for instructions.
Make sure the scanner cover is securely connected to the scanner’s
OPTION port. See Removing the Document Mat for instructions.
Make sure the Document Type setting (Home Mode) or Document Type
and Film Type settings (Professional Mode) are set correctly for your film/
slide type. See Selecting Basic Settings for instructions.
Make sure your film or slides are placed on the scanner correctly. See
Placing Film in the Holder or Placing Slides in the Holder for instructions.
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Negative Film Preview Images Look Strange
Make sure the Document Type setting (Home Mode) or Document Type
and Film Type settings (Professional Mode) are set correctly for your film.
See Selecting Basic Settings for instructions.
In normal preview, the dark area around the film and the frame of the film
holder is perceived as white. This alters the exposure and causes images to
appear darker. Create marquees on the image area you want to scan as
described in Previewing and Adjusting the Scan Area. Then click the Zoom
button to preview the area.
Try previewing images in thumbnail preview instead. See Previewing and
Adjusting the Scan Area for instructions on switching the preview type.
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Striped Rings Appear in Your Scanned Image
A ring-shaped pattern of stripes (called a Newton ring) sometimes appears on
scanned images of transparent materials if the film is curled.
Place the film with the base side facing up and preview using thumbnail preview.
mirroring icon in the Preview
Then flip the previewed image by clicking the
window. See Previewing and Adjusting the Scan Area for instructions.
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A Line Appears in the Previewed Image
The document table or transparency unit window may be dusty or scratched. Clean
the document table and transparency unit window as described in Cleaning the
Scanner. If you still have the problem, contact Epson. See Epson Technical Support
for details.
Top
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Optional Automatic Document Feeder Problems
You Cannot Scan Using the Automatic Document Feeder
Paper Jams in the Automatic Document Feeder

You Cannot Scan Using the Automatic Document Feeder
Make sure the optional ADF is installed correctly. See Installing the Automatic
Document Feeder for instructions.
Make sure you have selected either Office or Professional Mode in Epson Scan. See
Scanning Using the Automatic Document Feeder for instructions.
Make sure Auto Detect, ADF, or Document Table is selected as the Document
Source in Epson Scan. See Scanning Using the Automatic Document Feeder for
instructions.
If the ADF is open, close it and try scanning again.
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Paper Jams in the Automatic Document Feeder
If paper jams inside the ADF, open the ADF and remove any paper from the document table.
Then look to see if paper is extending from either end of the feeder.
To clear the jammed paper, follow these steps:
Turn off the scanner using its power switch.
If the ADF is open, close it.
Press down the release lever on the left side of the feeder to slightly raise the feeder
mechanism.

Slowly pull the jammed paper out of the feeder from the top or the bottom. Do not pull
the paper too hard or it may tear, making it more difficult to remove. Then let go of the
release lever.

If more paper is jammed in the ADF, open the access cover at the back of the feeder
and carefully pull out the paper.
Close the access cover.
Push the feeder mechanism back down until it clicks into place.

Caution:

Do not push the feeder mechanism with too much force.
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Uninstalling Your Scanning Software
Uninstalling Epson Scan
Uninstalling Other Epson Software
Uninstalling the On-screen User’s Guide
You may need to uninstall and then reinstall your scanner software to solve certain
problems or if you upgrade your operating system.

Uninstalling Epson Scan
Follow the instructions in the section for your operating system to uninstall Epson
Scan.

Uninstalling Epson Scan for Windows
Note:

To uninstall programs in Windows Vista, XP, or 2000, you need to log
on as a user with a Computer Administrator account (Windows Vista or
XP) or as a user who belongs to the Administrators group (Windows
2000).

Turn off the scanner using its power switch.
Disconnect the scanner’s USB cable from your computer.
Quit all running applications.
Do one of the following.

Windows Vista: Click

> Control Panel > Uninstall a Program

(located under Programs), or click
> Control Panel and then
double-click the Programs and Features icon.
Windows XP: Click Start > Control Panel > Add or Remove
Programs, or click Start > Control Panel and then double-click the
Add or Remove Programs icon.
Windows 2000: Click Start > Settings > Control Panel. Then doubleclick the Add/Remove Programs icon.
Select EPSON Scan from the list.
Click Uninstall/Change, then click Continue in the User Account Control
window (Windows Vista), or click Change/Remove (Windows XP and 2000).
When the confirmation window appears, click Next or OK.
In some cases, a message may appear to prompt you to restart the computer.
If so, make sure I want to restart my computer now is selected and click
Finish.

Uninstalling Epson Scan for Mac OS X
Turn off the scanner using its power switch.
Disconnect the scanner’s USB cable from your computer.
Quit all running applications.
Insert the scanner software CD-ROM into your Macintosh.
Open the Epson CD-ROM desktop icon, if necessary.
Double-click the Common folder, then double-click the EPSON Scan folder.

Note:

You may have to scroll down to see these folders.

Double-click the EPSON Scan Installer icon.

Note:

If the Authenticate dialog box appears, enter your password or phrase
and click OK.

Select Uninstall from the pull-down menu at the top and click Uninstall.
Follow the on-screen instructions to uninstall Epson Scan.
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Uninstalling Other Epson Software
Follow the instructions in the section for your operating system.

Uninstalling Other Epson Software for Windows
Note:

To uninstall programs in Windows Vista, XP, or 2000, you need to log
on as a user with a Computer Administrator account (Windows Vista or
XP) or as a user who belongs to the Administrators group (Windows
2000).

Quit all running applications.
Do one of the following.

Windows Vista: Click

> Control Panel > Uninstall a Program

> Control Panel and then
(located under Programs), or click
double-click the Programs and Features icon.
Windows XP: Click Start > Control Panel > Add or Remove
Programs, or click Start > Control Panel and then double-click the
Add or Remove Programs icon.
Windows 2000: Click Start > Settings > Control Panel. Then doubleclick the Add/Remove Programs icon.
Select EPSON Copy Utility 3.5 from the list.

Click Uninstall/Change, then click Continue in the User Account Control
window (Windows Vista), or click Change/Remove (Windows XP and 2000).
If a confirmation window appears, click OK.
Repeat steps 3 through 5 for each of the following programs.
Epson Event Manager
EPSON Perfection V500 Office Scanner Driver Update
Epson Scan PDF EXtensions
In some cases, a message may appear to prompt you to restart the computer.
If so, make sure I want to restart my computer now is selected and click
Finish.

Uninstalling Other Epson Software for Mac OS X
Note:

To uninstall applications, you must log on to a Computer Administrator
account. You cannot uninstall programs if you log on as a Limited
account user.

Quit all running applications.
Insert the scanner software CD-ROM into your Macintosh.
Open the Epson CD-ROM desktop icon, if necessary.
Double-click the Common folder, then double-click the Copy Utility folder.

Note:

You may have to scroll down to see these folders.

Double-click the Uninstaller icon.
In the Common folder, double-click the Event Manager folder.

Double-click the Installer icon.
Read the software license agreement and click Continue, then click Agree.
Select Uninstall from the pull-down menu at the top and click Uninstall.
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Uninstalling the On-screen User’s Guide
If you need to uninstall this on-screen User’s Guide, follow the steps here for your
operating system.

Uninstalling the Online User’s Guide for Windows
Note:

To uninstall programs in Windows Vista, XP, or 2000, you need to log
on as a user with a Computer Administrator account (Windows Vista or
XP) or as a user who belongs to the Administrators group (Windows
2000).

or Start > All Programs or Programs > EPSON > Perfection V500
Select
User’s Guide > Uninstall Perfection V500 User’s Guide.

Uninstalling the Online User’s Guide for Mac OS X
Drag the following folder and icon into the Trash.
The pv500_e folder in the Applications/EPSON/Guide folder.
The Perfection V500 User’s Guide icon on the desktop.
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Epson Technical Support
Internet Support
Speak to a Support Representative
Purchase Supplies and Accessories
Other Software Technical Support

Internet Support
Visit Epson’s support website for solutions to common problems. You can download
drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson
with your questions.
Top

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
Product name (Epson Perfection V500 Office)
Product serial number (located on the back of the scanner)
Proof of purchase (such as a store receipt) and date of purchase
Computer configuration
Description of the problem
Then call:
U.S.: (562) 276‐4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through
Friday.
Toll or long distance charges may apply. Days and hours of support are subject to
change without notice.
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Purchase Supplies and Accessories
You can purchase genuine Epson accessories from an Epson authorized reseller. To
find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase
online at http://www.epsonstore.com (U.S. sales) or http://www.epson.ca
(Canadian sales).
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Other Software Technical Support
Epson Scan
See Epson Technical Support.
ABBYY FineReader
(510) 226-6717, www.abbyyusa.com, support@abbyyusa.com
Adobe Photoshop Elements
(800) 642-3623, www.adobe.com/support
Top
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System Requirements
Windows System Requirements
Macintosh System Requirements
Make sure your system meets the requirements in these sections before using it with
your scanner.

Windows System Requirements
System

Microsoft Windows Vista, XP, XP Professional x64 Edition, or
2000 Professional
(Operating systems upgraded from Windows Millennium
Edition, 98, or 95 are not supported by the software.)
USB 2.0 Host Driver by Microsoft must be used if you are
connecting the scanner to a USB 2.0 port on the computer.

Interface

USB port 1.1 or later (Type A) built into the main board

Display

SVGA or higher resolution monitor
800 × 600, 24-bit (Full Color) screen resolution or higher
(Color and tone reproduction are subject to the display
capability of your computer system, including the video card,
display monitor, and software. See your system
documentation for details.)
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Macintosh System Requirements
System

PowerPC or Intel processor-based Macintosh computers
running Mac OS X 10.3.9 - 10.5.x. Fast User Switching on Mac
OS X or later is not supported.

Interface

Macintosh USB

Display

Color monitor with 800 × 600 screen resolution or higher, and
millions of colors
(Color and tone reproduction are subject to the display
capability of your computer system, including the video card,
display monitor, and software. See your system
documentation for details.)

Note:

Epson Scan does not support the UNIX File System (UFS) for Mac OS X.
You must install Epson Scan on a disk or in a partition that does not use
UFS.
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Scanner Specifications
General
Mechanical
Electrical
Environmental
Interfaces
Standards and Approvals
Note:

Specifications are subject to change without notice.

General
Scanner type

Flatbed color

Photoelectric
device

Color CCD line sensor

Effective pixels

54,400 × 74,880 pixels at 6400 dpi *
Scanning area may be restricted if resolution setting is
large.

Document size

Reflective:
216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size
Transparent:
35mm film strip: 12 frames at a time
35mm slides: up to 4 slides at a time
6 × 12 cm medium format: 1 frame at a time

Scanning
resolution

6400 dpi (main scan)
9600 dpi with Micro Step Drive (sub scan)

Output resolution

50 to 6400, 9600, and 12800 dpi (50 to 6400 dpi in 1 dpi
increments)

Image data

16 bits per pixel per color internal
16 bits per pixel per color external (maximum)

Interface

One USB 2.0 Hi-speed port

Light source

White LED, IR LED

* Optical Resolution is the maximum scan resolution of the CCD elements, using the
definition of ISO 14473. ISO 14473 defines optical resolution as the fundamental
sampling rate of the scan sensor.
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Mechanical
Dimensions

Width: 18.7 inches (475.0 mm)
Depth: 10.7 inches (272.0 mm)
Height: 4.4 inches (113.0 mm)

Weight

Approx. 8.8 lb (4.0 kg)
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Electrical
Note:

Check the label on the AC adapter or on the back of the scanner for voltage
information.

Scanner
Rated voltage

DC 24.0 V

Rated input current

1.3 A

Power consumption

16.0 W (17.5 W with ADF) Operating
7.5 W (6.5 W with ADF) Ready Mode
4.0 W Sleep Mode
0.4 W Power off

AC Adapter
100-120 V model

220-240 V model

AC adapter model

A411B

A411E

Rated input voltage

AC 100 to 120 V

AC 220 to 240 V

Rated input current

1.0 A

0.5 A

Rated input frequency

50 to 60 Hz

Rated output voltage

DC 24.0 V

Rated output current

1.3 A

Note:

The AC adapter model varies in certain locations.
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Environmental
Temperature

Humidity

Operating

50 to 95 ˚F (10 to 35 ˚C)

Storage

–13 to 140 ˚F (–25 to 60 ˚C)

Operating

10 to 80%, without condensation

Storage

10 to 85%, without condensation

Operating conditions

Ordinary office or home conditions.
Avoid operating the scanner in direct sunlight,
near a strong light source, or in extremely dusty
conditions.
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Interfaces

USB Interface
Interface type

Universal Serial Bus Specification Revision 2.0

Electrical
standard

Full Speed mode (12 Mbits per second) and Hi-Speed mode
(480 Mbits per second) of Universal Serial Bus Specification
Revision 2.0.

Connector type

One Type B port
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Standards and Approvals

Scanner
U.S. model:
EMC

FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

AC Adapter
U.S. model:
Safety

UL60950-1
CAN/CSA-C22.2 No. 60950-1

EMC

FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR22 Class B
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Optional Automatic Document Feeder Specifications
General
Electrical
Environmental
Mechanical

General
Product code

B12B813391

Paper input

Face-up loading

Paper output

Face-down ejection

Paper capacity

Maximum 0.2 inch (6 mm) stack height

Paper types

Bond paper, fine-quality paper, check paper, and
recycled paper
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Electrical
Rated voltage

DC 24 V, DC 5 V

Input voltage

DC 24 V to DC 26.4 V
DC 5 V ±5%

Input current

24 V: 0.8 A
5 V: 0.2 A
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Environmental

Temperature

Humidity

Operating

50 to 90 ˚F (10 to 32 ˚C)

Storage

-4 to 140 ˚F (-20 to 60 ˚C)

Operating

20 to 80%, without condensation

Storage

10 to 85%, without condensation
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Mechanical
Dimensions

Width: 319 mm (12.6 inches)
Depth: 539 mm (21.2 inches)
Height: 137 mm (5.4 inches)

Weight

Approx. 2.4 kg (5.3 lb)
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